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Preface

Audience for This Guide

Welcome to Release 11i of the Oracle Quoting Implementation Guide.

This guide assumes you have a working knowledge of the following:

The principles and customary practices of your business area.
Oracle Quoting
The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications
product information.

How To Use This Guide

This guide contains the information you need to understand and use Oracle
Quoting.

Chapter 1 provides an overview of the Oracle Quoting application and its
components, and lists features and functionality new in this release.

Chapter 2 lists the mandatory and conditional dependencies of Oracle Quoting.
Chapter 3 provides an overview of the implementation process.

Chapter 4 lists the specific tasks involved in the implementation of Oracle
Quoting.

Chapter 5 contains a list of tasks for verifying the implementation.

Xi



= Chapter 6 contains FAQs and troubleshooting tips.

»  Chapter 7 provides information on integrating Oracle Quoting with Oracle
Approvals Management.

= Chapter 8 provides information on integrating Oracle Quoting with Oracle
Contracts Core.

= Appendix A contains a complete list of Oracle Quoting’s profile options.
= Appendix B contains a complete list of Oracle Quoting’s seeded lookup types.
= Appendix C contains scenarios for new security functionality.

= Appendix D contains a list of the seeded Oracle Approvals Management
attributes necessary for using Approvals functionality in Oracle Quoting.

= Appendix E contains a list of Oracle Quoting’s seeded caches.

Typographic Conventions

The following table lists the typographic conventions used in this manual:

Convention Meaning

italic text Book titles

Courier text User commands and file content examples

UPPERCASE Structured Query Language (SQL) commands, initialization
parameters, profile options, responsibilities, or environment
variables

boldface text Menu, button, keyboard, form options, and profile options

Emphasized words or phrases

<> Angle brackets enclose user-supplied names.

Note: Do not type the angle brackets.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible, with good usability, to the disabled community. To that end, our
documentation includes features that make information available to users of
assistive technology. This documentation is available in HTML format, and contains
markup to facilitate access by the disabled community. Standards will continue to
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evolve over time, and Oracle Corporation is actively engaged with other
market-leading technology vendors to address technical obstacles so that our
documentation can be accessible to all of our customers. For additional information,
visit the Oracle Accessibility Program Web site at
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen
reader, may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, JAWS may not always read a line of text that
consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation This
documentation may contain links to Web sites of other companies or organizations
that Oracle Corporation does not own or control. Oracle Corporation neither
evaluates nor makes any representations regarding the accessibility of these Web
sites.

Other Information Sources

You can choose from many sources of information, including online documentation,
training, and support services, to increase your knowledge and understanding of
Oracle Quoting.

If this guide refers you to other Oracle Applications documentation, use only the
Release 11i versions of those guides.

Online Documentation

All Oracle Applications documentation is available online (HTML or PDF). Online
help patches are available on MetaLink.

Related Documentation

Oracle Quoting shares business and setup information with other Oracle
Applications products. Therefore, you may want to refer to other product
documentation when you set up and use Oracle Quoting.

You can read the documents online by choosing Library from the expandable menu
on your HTML help window, by reading from the Oracle Applications Document
Library CD included in your media pack, or by using a Web browser with a URL
that your system administrator provides.
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If you require printed guides, you can purchase them from the Oracle Store at
http:/ /oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI) available with this release of Oracle Quoting (and any
other Oracle Applications products). This guide also includes information on
setting user profiles, as well as running and reviewing reports and concurrent
processes.

You can access this user’s guide online by choosing “Getting Started with Oracle
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Quoting User Guide

This document provides users with information on the general principles and
procedures of creating and managing quotes in Oracle Quoting.

Implementing Oracle CRM: ERP Functional Checklist

This document provides users with a list of verification tasks to perform before
using CRM applications.

Oracle Pricing User’s Guide

This document provides users with information on setting up promotion codes,
pricing agreements, and price lists that are used when creating quotes in Oracle
Quoting.

Oracle Bill of Materials User’s Guide

This user guide explains how to set up Oracle Bill of Materials, which Oracle
Quoting uses to access information about components of products.

Oracle General Ledger User Guide

This document provides information on exchange rates, and setting up ledgers and
books.
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Oracle Inventory User’s Guide

This document provides users with information on setting up products in Oracle
Inventory.

Oracle Order Management Suite Implementation Manual

This manual explains the steps necessary to implement Oracle Order Management,

which Oracle Quoting uses to transform quotes into orders.

Oracle Receivables User’s Guide

This document provides users with setup information for Oracle Receivables as
well as information about creating customers and setting up tax information.

Oracle Approvals Management Implementation Guide

This document provides setup information for Oracle Approvals Management
(OAM). Oracle Quoting integrates with OAM to provide approvals functionality
during the quoting process.

Oracle Contracts Core Concepts and Procedures

This manual provides information on the profiles needed to integrate Oracle
Quoting with Oracle Contracts for Sales.

Oracle Contracts for Sales Concepts and Procedures

This manual provides set up information for Oracle Contracts for Sales, which
integrates with Oracle Quoting to provide Contracts functionality.

Oracle Sales Online Implementation Guide

This guide provides setup information for Oracle Sales Online. Oracle Quoting -
HTML integrates with Oracle Sales Online to complete the opportunity-to-order
workflow.

Oracle TeleSales Implementation Guide

This guide provides setup information for Oracle TeleSales. Oracle Quoting - Forms

integrates with Oracle TeleSales to complete the opportunity-to-order workflow.

Oracle Workflow Guide
This guide provides the user with information about notifications, which Oracle
Quoting uses during the approvals and contract request processes.
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XVi

Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology stack,
architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide
also introduces the concepts behind Applications-wide features such as Business
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle
Applications products. In Release 11i, much of the installation process is handled
using Oracle Rapid Install, which minimizes the time to install Oracle Applications,
the Oracle8 technology stack, and the Oracle8i Server technology stack by
automating many of the required steps. This guide contains instructions for using
Oracle Rapid Install and lists the tasks you need to perform to finish your
installation. You should use this guide in conjunction with individual product
user’s guides and implementation guides.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and
lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i.
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as AutoUpgrade,
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to
run the AD utilities. This guide also provides information on maintaining the
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.



Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff. It describes the Oracle Application Object Library components
needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle
Applications development staff. It describes the UI for the Oracle Applications
products and how to apply this Ul to the design of an application built by using
Oracle Forms.

Other Implementation Documentation

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference information for the
Oracle Quoting implementation team, as well as for users responsible for the
ongoing maintenance of Oracle Applications product data. This manual also
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (eTRM) contains database diagrams and a
detailed description of database tables, forms, reports, and programs for a specific
Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle
applications, and write custom reports for Oracle Applications products. Oracle
eTRM is available on Metalink

Oracle Applications Message Reference Manual

This manual describes Oracle Applications messages. This manual is available in
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide

Many CRM products use components from CRM Application Foundation. Use this
guide to correctly implement CRM Application Foundation.
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xviii

Training and Support

Training

Oracle offers training courses to help you and your staff master Oracle Quoting and
reach full productivity quickly. You have a choice of educational environments. You
can attend courses offered by Oracle University at any one of our many Education
Centers, you can arrange for our trainers to teach at your facility, or you can use
Oracle Learning Network (OLN), Oracle University's online education utility. In
addition, Oracle training professionals can tailor standard courses or develop
custom courses to meet your needs. For example, you may want to use your
organization’s structure, terminology, and data as examples in a customized
training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals
provides the help and information you need to keep Oracle Quoting working for
you. This team includes your Technical Representative, Account Manager, and
Oracle’s large staff of consultants and support specialists with expertise in your
business area, managing an Oracle8i server, and your hardware and software
environment.

OracleMetalLink

OracleMetaLink is your self-service support connection with web, telephone menu,
and e-mail alternatives. Oracle supplies these technologies for your convenience,
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain
information and advice from technical libraries and forums, download patches,
download the latest documentation, look at bug details, and create or update TARs.
To use MetaLink, register at (http:/ /metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows:
Technical Libraries/ERP Applications/Applications Installation and
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the
Self-Service Toolkit page as follows: Technical Libraries/ERP
Applications/Applications Installation and Upgrade.



Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data
Browser, database triggers, or any other tool to modify Oracle Applications data
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using
Oracle Applications can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a
row in one table without making corresponding changes in related tables. If your
tables get out of synchronization with each other, you risk retrieving erroneous
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps
track of who changes information. If you enter information into database tables
using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
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Getting Started

This section of the Oracle Quoting Implementation Guide contains the following
chapters:

= Chapter 1, "Introduction”
s Chapter 2, "Before You Begin"






1

Introduction

This chapter provides information on the following topics:
= Oracle Quoting Overview

s New in this Release
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Oracle Quoting Overview

1.1 Oracle Quoting Overview

Oracle Quoting enables simple, secure creation and management of customer
quotes across all sales and interaction channels. Organizations can propose product
solutions and negotiate prices, while enforcing consistent business rules throughout
the sales cycle.

Oracle Quoting users can create quotes using modifiable templates, add and
configure complex products, and perform real-time global availability checks. Users
can accept product trade-ins, assign sales credits, and manually adjust prices.
Quoting integration with Contracts allows users to negotiate a quote with a sales
contract. Complex customer approval chains are supported and users can view and
change customers’ existing installation information, publish and print quotes, and
eventually convert quotes to orders.

Oracle Quoting is available with an HTML and a Forms user interface. Oracle
Quoting-HTML is integrated with Oracle Sales Online and Oracle Quoting-Forms
with Oracle TeleSales.

1.1.1 Oracle Quoting Features

Oracle Quoting allows you to:

= Add configured products to quote (including guided selling)

= Add service products to quote

= Save/personalize searches (HTML only) and use advanced search capabilities
= Allocate sales credits

» Initiate approvals, using the Oracle Approvals engine, with out-of-the-box
notifications

»  Check availability of products

= Convert quotes to orders

= Copy existing quotes

»  Create notes, tasks (HTML only), and attachments
»  Create quote from opportunity

»  Create quotes from templates (HTML only)

= Allow terms and conditions to be displayed with and printed on the quote
through enhanced integration with Oracle Contracts
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Print quotes in PDF and RTF formats with enhanced printing

Enforce key business practices in the sales cycle with enhanced quote status and
transition model

Control quote access and update with quote security
Restrict salesperson’s quote creation ability to specific customers
Search Customer Install Base for Trade-Ins (HTML only)

Search customer Install Base and Pending Orders for products to which you can
apply services

Share quotes with customers via the Oracle iStore web storefront
Split-ship products
Support flexible pricing within a quote including manual price overrides

Authorize credit card payment

1.2 New in this Release

This document describes functionality to be delivered in the Oracle E-Business Suite
11.5.9 release. If you are implementing this product prior to the release, using
product minipacks or family packs, some new functionality may be dependent on
integration with other Oracle products. Please consult MetaLink for relevant
product patches and documentation.

The following functionality is new in this release:

Customer Credit Checking

Oracle 8i interMedia-based Product Search

Quoting to Prospects

Quote Pricing and Tax Calculation on Request
Quote and Template Line Copying

Defaulting of Shipping and Billing Information
Terms Substitution

Compliance with Latin American Tax Requirements
Improved Configuration and Display

Enhanced Line Numbering
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Account Description Display
Solution-Based Modeling

HTML Ul Only

Selectable Columns

Oracle Proposals Integration
Base UOM Modification
Streamlined Quote Creation Flow

Line-Level Charge Displaying

Forms Ul Only

Enhanced User Interface
Basic and Advanced Quote Searches

Improved Customer Search
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Before You Begin

This chapter provides an overview of what you need to have installed,
implemented, and verified before implementing Oracle Quoting. Topics include:

= Related Documentation

= Installation Verification

= Oracle Quoting Dependencies
= Mandatory Dependencies

= Conditional Dependencies

= Dependency Verification

Before You Begin 2-1



Related Documentation

2.1 Related Documentation
Oracle Quoting User Guide

Oracle Order Capture Foundation API Reference Manual
Oracle Quoting API Reference Guide

2.2 Installation Verification

Before proceeding with implementation of Oracle Quoting and its dependencies,
you must verify that you have installed Oracle Applications correctly. See Installing
Oracle Applications for more information.

2.3 Oracle Quoting Dependencies

Oracle Quoting depends on other Oracle modules and applications to provide
additional functionality. Mandatory dependencies are required for Oracle Quoting
to function properly. Conditional dependencies, when integrated, provide
additional capabilities.

2.4 Mandatory Dependencies

Oracle Quoting requires that the following applications be installed and
implemented.

s Oracle Receivables — Provides tax information and customer account
information. Refer to the Oracle Receivables User Guide for complete setup
information.

= Oracle Advanced Pricing — Allows set up of price lists, discounts,
adjustments, and promotions. Refer to the Oracle Advanced Pricing User’s Guide
for complete setup information.

= Oracle Bill of Materials — Contains information about the components
associated with a product. Refer to the Bill of Materials User’s Guide for complete
setup information.

= Oracle General Ledger — Enables set up of ledgers and books and store
exchange rates. Refer to the Oracle General Ledger User Guide for complete setup
information.
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= Oracle Inventory — Provides Availability to Promise (ATP) and reservation
functions, and all product information from Inventory. Refer to the Oracle
Inventory User’s Guide for complete setup information.

= Oracle Order Management — Allows creation of orders from quotes. Refer to
the Oracle Order Management Suite Implementation Manual for complete setup
information.

2.4.1 Setting up Oracle Receivables

Oracle Quoting uses Oracle Receivables to store customer information and access
tax information. Customer information is stored in the Trading Community
Architecture (TCA) schema.

2.4.2 Setting up Address Locations

You can set up valid addresses in Oracle Receivables. Failure to set up address
combinations can result in errors when attempting to create customers.

Login

Log in to Oracle Forms.

Responsibility
Receivables Manager

Steps
1. Select Setup > Tax > Locations.

2. Follow the procedure for defining tax locations and rates outlined in the Oracle
Receivables User Guide.

2.4.3 Address Formats

Oracle Quoting provides user country specific address information fields and
performs validation on each country’s mandatory fields.

To set up country specific address formats in Oracle Receivables:

Login
Log in to Oracle Forms.
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Responsibility
Receivables Manager

Steps

1. Choose Setup > System > Countries.
The Countries and Territories window opens.
2. Search for country as follows:
a. Choose View > Query By Example > Enter.

b. In the Country/Territory field of the Countries and Territories window,
enter the name of the country for which you want to choose an address
format.

c. Press Ctrl + F11 to submit the query.

The Countries and Territories window is populated with the data for the
country.

Note: Alternatively, you can choose View > Find All to populate
the Countries and Territories window with data for every country.

3. In the Countries and Territories window, choose an address format from the
country’s Address Style list of values (LOV).

4. Save the form.

When the user enters an address, the address style set up for that user’s selected
country is displayed.

2.4.4 Setting up Oracle Advanced Pricing

Oracle Quoting uses Oracle Advanced Pricing to set up essential pricing
information including:

»  Price Lists — Every product you want to sell must be on a price list. In Oracle
Advanced Pricing you set up price lists, add inventory items to them, and
modify them as needed.

»  Modifiers — Modifiers enable you to set up price adjustments, such as
discounts and surcharges, and freight and special charges. A Promotion is an
example of a modifier.
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= Agreements — Through Oracle Advanced Pricing, Quoting users can set up
agreements with customers. Agreements allow you to define payment terms,
prices, and freight terms for a specific customer.

For information on setting up price lists, modifiers or agreements, see the Oracle
Advanced Pricing User’s Guide or the Oracle Order Management Suite Implementation
Manual.

Note: Oracle Quoting - HTML does not support modifiers that
have formulas with pricing attributes. However, if the formulas are
very simple—contain only numeric constants and do not require
pricing attributes to be passed in order to evaluate them—Quoting -
HTML does support them.

2.4.5 Attributes

Attributes are used to create criteria for the Pricing Qualifiers you set up in Oracle
Pricing. For example, use the Customer Name attribute to create Pricing Qualifiers
limiting available promotions based on Customer Name.

For more information on attributes in Oracle Pricing, refer to the Oracle Pricing
User’s Guide.

Attributes Supported by Oracle Quoting
The following table lists the Oracle Pricing Attributes Supported by Oracle Quoting.

Table 2-1 Attributes Supported by Oracle Quoting

Pricing or Qualifier

Context Attribute Name Pricing Level Attribute
Customer Account Type Line/Header Qualifier
Customer Agreement Name Line/Header Qualifier
Customer Agreement Type Line/Header Qualifier
Customer Bill To Line/Header Qualifier
Customer Customer Class Line/Header Qualifier
Customer Customer Name Line/Header Qualifier
Customer GSA Indicator Line/Header Qualifier
Customer Invoice To Party Site  Line/Header Qualifier
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Table 2-1 Attributes Supported by Oracle Quoting

Pricing or Qualifier

Context Attribute Name Pricing Level Attribute
Customer Party Id Line/Header Qualifier
Customer Sales Channel Line/Header Qualifier
Customer Ship To Line/Header Qualifier
Customer Ship To Party Site Line/Header Qualifier
Customer Site Use Id Line/Header Qualifier
Item ALL_ITEMS Line Pricing
Item Inventory Item Id Line Pricing
Item Item Category Line Pricing
Item Segment 1 (Key item Line Pricing
flexfield segments)
Item Segment 2 Line Pricing
Item Segment 3 Line Pricing
Item Segment 4 Line Pricing
Item Segment 5 Line Pricing
Item Segment 6 Line Pricing
Item Segment 7 Line Pricing
Item Segment 8 Line Pricing
Item Segment 9 Line Pricing
Item Segment 10 Line Pricing
Item Segment 11 Line Pricing
Item Segment 12 Line Pricing
Item Segment 13 Line Pricing
Item Segment 14 Line Pricing
Item Segment 15 Line Pricing
Item Segment 16 Line Pricing
Item Segment 17 Line Pricing
Item Segment 18 Line Pricing
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Table 2-1 Attributes Supported by Oracle Quoting

Pricing or Qualifier

Context Attribute Name Pricing Level Attribute
Item Segment 19 Line Pricing
Item Segment 20 Line Pricing
Line Volume Item Amount Line Pricing
Line Volume Item Quantity Line Pricing
Line Volume Period1 Item Line Pricing
Quantity
Line Volume Period2 Item Line Pricing
Quantity
Line Volume Period3 Item Line Pricing
Quantity
Modlist Price List Line/Header Qualifier
Modlist Promotion Number  Line/Header Qualifier
Order Customer PO Line Qualifier
Order Line Category Line Qualifier
Order Line Type Line Qualifier
Order Order Category Line Qualifier
Order Order Type Line/Header Qualifier
Order Pricing Date Line Qualifier
Order Request Date Line Qualifier
Order Shippable Flag Line/Header Qualifier
Pricing Attributes Model Id Line Pricing
Pricing Attributes Parent List Price Line Pricing
Segment Market Segment Line/Header Qualifier
Segment Target Segment Line/Header Qualifier
Terms Payment Terms Line/Header Qualifier
Terms Shipping Terms Line/Header Qualifier
Territory Territory Line/Header Qualifier
Volume Line Volume Line Qualifier

Before You Begin 2-7



Mandatory Dependencies

Table 2-1 Attributes Supported by Oracle Quoting

Pricing or Qualifier

Context Attribute Name Pricing Level Attribute
Volume Line Weight Line Qualifier
Volume Order amount Line Qualifier
Volume Order Amount Header Qualifier
Volume Order Qty Line Qualifier
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2.4.6 Setting up Oracle General Ledger

When setting up Oracle General Ledger, you must define:

A chart of accounts with a value set, and Accounting Flexfield Structure as well
as segments and segment values

A calendar
Currencies (enable currencies in order to use them)

A set of books

Refer to the Oracle General Ledger User Guide for information on how to perform
these tasks.

2.4.7 Setting up Oracle Inventory

Oracle Inventory serves as a repository for the items available for purchase in
Oracle Quoting. Oracle Quoting supports the use of all items as long as they are
Orderable.

Currently, in both the Forms and HTML versions of Oracle Quoting, product and
related product searches are filtered as follows:

The current date must be within the start and end date range set for the
product, if any.

The product must be valid for the inventory organization of the operating unit
in which the quote is created.

The product must be in the default category set defined for the functional area
"Order Entry." This condition is not applied for related items that are filtered on
the basis of an existing item relationship with the selected product.

The product must have the "Customer Orders Enabled" flag enabled.

Note: In the Forms U], the "Returnable" flag must be enabled if the Line
Category Code is Return.

The BOM Item Type must be Model or Standard.
The Primary UOM is not ENR.

2.4.8 Setting up Oracle Order Management

To avoid setup problems, perform the following setups in Oracle Order
Management.
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Setting up the Default Item Validation Organization

You must set up the default Item Validation Organization for your operating unit
in Oracle Order Management. This can be done in the Oracle Order Management
application Setup > Parameter menu. For more information, refer to the Oracle
Order Management Suite Implementation Manual.

Setting up Shipping Methods in Oracle Order Management

Oracle Quoting and Oracle Order Management treat shipping method modifier
types differently. It is important to select only one modifier type when setting up
an Oracle Quoting shipping method in Oracle Order Management.

For more information or to troubleshoot Oracle Quoting shipping method modifier
types see Section 6.3.4, "Quote Status Remains Contract Pending When Contract is
Canceled".

Assign Workflow to the Transaction Type Selected in ASO: Default Order Type
To assign workflow for the transaction type you select in ASO: Default Order Type:

Login

Login to Oracle Forms.

Responsibility
Oracle Order Management Super User

Prerequisites
You must have a transaction type set up.

Steps

1. Navigate to Setup > Transaction Type > Define.

2. Query for the value in ASO: Default Order Type.

2.5 Conditional Dependencies

The following conditional dependencies provide additional functionality but are
not required for Oracle Quoting to function.

= Oracle Approvals Management — Allows users to create an approval chain.
Refer to the Oracle Approvals Management Implementation Guide for complete
setup information.
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= Oracle Configurator — Configures model items. Refer to the Oracle Configurator
Installation Guide and Oracle Configurator Implementation Guide for complete
setup information.

m  Oracle Contracts for Sales — Enables users to include standard and
non-default contracts with quotes. Refer to the Oracle Contracts for Sales Concepts
and Procedures for more information.

= Oracle iPayment — Enables credit card authorizations. Refer to the Oracle
iPayment Implementation Guide for complete setup information.

= Oracle Install Base — Provides a list of all customer’s products and installation
details. Refer to the Oracle Install Base Implementation Guide for complete setup
information.

= Oracle Reports Developer 6i — Centralizes report processing and manages
reporting. Refer to Oracle Reports Developer Building Reports and Oracle Reports
Developer Publishing Reports.

= Oracle Reports Server — Enables development of print quote. Oracle Reports
Server must be configured for quote printing. Refer to Oracle Reports Developer
Getting Started for complete setup information.

= Oracle Sales Online — Allows sales representatives to create quotes in a
campaign-to-order business flow from the HTML UL Refer to the Oracle Sales
Online Implementation Guide for complete setup information.

m  Oracle Service Contracts — Provides contract details for service items. Refer to
the Oracle Contracts for Service Implementation Guide for complete setup
information.

= Oracle TeleSales — Allows sales representatives to create quotes in a
campaign-to-order business flow from the Forms UI. Refer to the Oracle
TeleSales Implementation Guide for complete setup information.

= Oracle Workflow — Provides notifications related to Approvals and Contracts
integration. Refer to the latest version of the Oracle Workflow Guide for more
information.

2.6 Dependency Verification

Refer to the following documentation to ensure that all dependencies are installed,
implemented, and set up correctly. These documents are available on MetaLink.

Oracle CRM Application Foundation Implementation Verification Checklist
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Implementing Oracle Quoting

This section of the Oracle Quoting Implementation Guide contains the following
chapters:

= Chapter 3, "Implementation Overview"

= Chapter 4, "Implementation Tasks for Oracle Quoting"
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Implementation Overview

3.1 Oracle Quoting Implementation Overview

Mandatory implementation steps are required for Quoting to function properly.
Optional steps provide enhanced functionality. This chapter contains:

= Process Description

= Implementation Task Sequence
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3.1.1 Process Description

Sales representatives can use Oracle Quoting to create and manage quotes, and if
approved by the customer, convert those quotes into orders.

To effectively implement Oracle Quoting, you must perform the following
mandatory tasks:

= Set up quote status

= Set system profile options

= Enable the cache for the HTML UI

For enhanced functionality, set up the following:
= Security

= Web publishing

= Sales supplement templates

= Sidebar menu (HTML UlI)

Approvals

s Contracts
s Credit Checking

s interMedia Search

Note: If you are implementing Oracle Quoting in a multi-org
environment, please refer to the Multiple Organizations in Oracle
Applications manual available on MetaLink.

3.1.2 Implementation Task Sequence

The following table describes the implementation process for Oracle Quoting.
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Table 3-1 Oracle Quoting Process

Step Description Mandatory Performed By

1 Set up quote status and quote Yes Quoting Sales Manager
status transitions.

Define new or modify seeded
quote statuses, status transitions,
and extensibility rules based on
business needs.

2 Set up system profile options. Yes System Administrator

Define system profile values. These
affect the way Oracle Quoting
looks and performs.

3 Enable cache in the HTML UL Yes System Administrator
Setup is mandatory for Quoting -
HTML users.

4 Assign a seeded or customized Yes System Administrator
Oracle Quoting responsibility to
user.

5 Set up default expiration date Yes System Administrator
using one of the available methods.

6 Set up overrideable modifiers in Mandatory if Oracle Pricing
Oracle Advanced Pricing if ASO:  using discounts ~Manager
Discounting Privilege is set to or surcharges
Full.

7 Set up the Sidebar Menu (HTML).  Optional Application Developer

Customize the menu if you disable
any functionality.

8 Customize the Lines page (HTML). Optional Applications
Developer Common
Modules
9 Disable Actions menus and buttons Optional Quoting Sales Manager
(HTML).
10 Customize the Overview page Optional Application Developer
(HTML). Common Modules

Implementation Overview 3-3



Oracle Quoting Implementation Overview

Table 3-1 Oracle Quoting Process

Step Description Mandatory Performed By

11 Set up Security. Mandatory if System Administrator
Set security specific profile options, using Security CRM Administrator
and create resources and groups.

12 Set up print quote. Optional System Administrator
To have personalized print quote
reports, customize the report in
Report Builder.

13 Set up Manual Pricing Request Optional System Administrators
options.

14 Enable interMedia Search Optional iStore Concurrent

Programs
System Administrator

15 Set up Account Creation Optional System Administrator
requirements

16 Set up Proposals. Optional Application Developer
Enable the Proposals link in the
Overview sidebar.

17 Set up Web Publishing Mandatory to System Administrator
functionality. publish quotes iStore Administrator
Set specific profiles and set up
specialty stores in iStore.

18 Set up Approvals. Mandatory for ~ System Administrator
To enable approvals, set specific approvals AME (Approvals
profile options and conditions and Management Engine)
rules. Administrator

19 Set up Contracts. Mandatory to System Administrator
To enable contracts, set specific g:ictlﬁldig?:strads Contracts
profile options and workflow ! Administrator
notifications.

20 Set up Credit Check functionality =~ Optional Order Management

To enable credit check, set specific
profile option.

Super User (for credit
check rules)

System Administrator

3-4 Oracle Quoting Implementation Guide



Oracle Quoting Implementation Overview

Table 3-1 Oracle Quoting Process

Step

Description Mandatory Performed By

21

Set up Sales Supplement Optional Quoting Sales Manager
functionality.

Use this functionality if you require
supplemental information on
quotes that will not pass into
Oracle Order Management. Enable
sales supplement functionality in
Oracle Forms and view it in the
HTML UL

22

Modify seeded Lookup Types. Optional Quoting Sales Manager

Some seeded lookups types are Application Developer
extensible and can be modified.

23

Create additional attachments Optional Application Developer
document categories.

Oracle Quoting supports one
document category. You can create
additional document categories as
needed.

24

Define descriptive flexfields. Optional Application Developer

Customizable, undefined fields on
the Oracle Quoting form that the
application developer can define as
needed.
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Implementation Tasks for Oracle Quoting

This topic group details the steps necessary to implement Oracle Quoting.

Setting Up Quote Status and Quote Status Transitions
Setting System Profile Options

Enabling the Cache for Oracle Quoting (HTML)

Assigning a Seeded Oracle Quoting Responsibility to a User
Setting up the Default Expiration Date

Setting up Overrideable Modifiers

Enabling or Disabling Sidebar Menu Functionality (HTML)
Customizing the Lines Pages (HTML)

Disabling Action Menus and Buttons (HTML)

Customizing the Overview Page (HTML)

Setting up Security

Setting Up the Print Quote Functionality

Setting up Manual Pricing and Tax Calculation Request Options
Enabling interMedia Search

Setting Up Account Creation Requirements for Quotes
Setting up Web Publishing Functionality

Setting up Approvals

Setting up Contracts

Setting Up Credit Check Functionality
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= Setting up Sales Supplement Templates
»  Modifying Seeded Lookup Types
= Creating Additional Attachments Document Categories

s Defining Descriptive Flexfield Information
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4.1 Setting Up Quote Status and Quote Status Transitions
Use this procedure to perform the following tasks:
= Add new quote statuses
= Enable or disable existing quote statuses
= Set up the allowable status changes, or transitions, for each status
= Indicate a read-only status
= Set up quote versioning (Forms only)

The status of a quote indicates the evolution of a quote from the initial offer to order
placement. Quote statuses and transitions reflect your quote cycle. You may also
define your quote statuses to determine what kind of changes a sales representative
can make to the quote.

If a quote status is read only you may perform the following:
= Modify tasks and notes
= Change the quote status, as long as the transition is valid

= Publish or unpublish a quote, if publishing is enabled and the quote satisfies
publishing criteria

= Modify payment information, prior to submission of order
= Add attachments; you cannot remove, or replace existing attachments

If a status is user maintainable, the application administrator can modify any
attribute of the status.

If a status is not user maintainable, it means that:
s The application administrator cannot remove the status from the system.

s The application administrator cannot change any attribute of the status except
the name appearing in the status list of values

Oracle Quoting is delivered with predefined quote statuses. You can define new
quote statuses to reflect your business processes. But you cannot modify seeded
statuses unless they are user maintainable. In addition, you cannot delete any
statuses. You must deactivate those statuses you no longer want to use.

Implementation Tasks for Oracle Quoting 4-3



Setting Up Quote Status and Quote Status Transitions

Note: Users with the System Administrator responsibility can
define an Oracle Quoting default quote status using the profile
option ASO: Default Quote Status. This default status is applicable
to new quotes as well as to new versions of existing quotes.

The following table lists the seeded quote statuses.

Table 4-1 Seeded Quote Statuses

Quote Status Description Read-only
Approval Canceled  Sales representative canceled the approval process. No
Approval Pending Quote is pending approval, and is read-only. Yes
Approval Rejected ~ Approval was rejected by the approvers. No
Approved Approved by the necessary approvers. Yes
Contract Canceled  Contract canceled by the contract administrator. Yes
Contract Pending Contract is in review with the contract specialist. Yes
Contract Required =~ Contract specialist to author and approve contract Yes

required after approval process.

Draft Initial status of quote. No

Inactive No more activity allowed on the quote. Yes

Order Submitted Quote has been submitted as an order to Oracle Order  Yes
Management.

Store Draft For iStore internal use only. Allows iStore to have a No

Draft to Order flow that is separate from Quoting.

The statuses in the following table exist for backward compatibility (for previous
version of Oracle Quoting), but there is no functionality associated with them.

Quote Status

Description Read-only

Bid

Could be used to show that the quote was presented to No
a customer.

Lost

Could be used to show that the customer No
declined /rejected the quote.
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Quote Status Description Read-only

Problem Could be used to show there is a problem submitting ~ No
the quote as an order.

Note: The system will not automatically set this status
if the order is not submitted.

Reviewed Could be used to show that the quote was reviewed No
internally.

The statuses Ordered and Entered are obsolete in this release. They still appear in the
Quote Status setup form but they will be locked. You will not be able to create any
transitions to them, nor can you enable them.

Note: If you designated a quote status as read-only in a previous
release of Oracle Quoting, it will not be overwritten in this release,
regardless of the out-of-box designation. For example, if you
defined the status Lost as read-only in 11.5.6, it will remain read-only
in this release.

4.1.0.1 Rules for Quote Status Changes

Status transitions are regulated to prevent accidental changes, such as reverting an
ordered quote status back to a non-ordered status.

Not all transitions are seeded. You may have to set up certain transitions to use
additional functionality. For example, the status transition Draft to Inactive is not
seeded but is necessary if you want to inactivate quotes.

Note: You cannot set up a transition from a status to itself.

The following table shows the seeded transition rules for quote status changes.

Table 4-2 Seeded Quote Status Transitions

From To User Maintainable
Approval Pending Approved No
Approval Pending Approval Canceled No
Approval Pending Approval Rejected No
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Table 4-2 Seeded Quote Status Transitions

From To User Maintainable
Approval Pending Contract Required No
Contract Pending Approved No
Contract Pending Contract Cancelled No
Contract Required Contract Pending No
Store Draft Draft No
Store Draft Inactive No
Store Draft Order Submitted No
Store Draft Contract Pending No

If a seeded transition is user maintainable, the application administrator can disable
the transition. If the transition is not user maintainable, the application
administrator cannot disable the transition as this is used by the system to enforce
functionality.

You cannot create new transitions to the following statuses:
= Approval Canceled

= Approval Rejected

= Approved

= Contract Canceled

= Contract Required

= Store Draft

You cannot create new transitions from the following statuses:
= Approval Pending

= Contract Canceled

= Contract Pending

= Contract Required

s Order Submitted

= Store Draft
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Login

Log in to Oracle Forms.

Responsibility
Quoting Sales Manager

Prerequisites

None

Steps

1. Navigate to the Quote Status Setup window.
2. Toadd a new quote status:

a. In the Quote Statuses region, select a blank entry line or the line below
which to insert the new entry.

b. Enter the status code. This is the internal name and is not seen by the user.

c. Enter the status name and status description. These are displayed in the list
of values for users.

d. To enable end-user initiated changes to the quote, check the Update
Allowed box. To make the status read-only, uncheck the Update Allowed
box.

Note: A user can fully update a quote in read-only status if the
system administrator sets the profile option ASO: Status Override
to Yes for that specific user. The user must have update access to
the quote.

e. Forms Only: To create a new version when the user selects the save icon for
a quote, check the Auto Versioning box for the new status.

f. To enable the status, check the Enabled box.

g. Select Save on the toolbar.

3. To set up the rules that determine permitted status transitions for a particular
status:

a. In the Quote Statuses region, select the status to set up.
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b. In the Allowed Transition to Status region, use the Code LOV to select an
allowable transition status. You can allow transitions to multiple statuses.

c. Repeat the previous step for each permitted transition status.
d. To disable an existing status, uncheck the Enabled box.

e. Select Save on the toolbar.

4.2 Setting System Profile Options

Use Appendix A, "Oracle Quoting Profile Options" to identify the profile options to
set for your specific implementation. There is no recommended order for setting
profile options.

Login

Log in to Oracle Forms.

Responsibility
System Administrator

Prerequisites
None

Steps
1. Navigate to Profile > System.

The Find System Profile Values window opens.
2. Check the Site box.
3. Enter ASO% in the Profile Name field.
4. Select the Find button.

The System Profile Values window opens, displaying all existing Oracle
Quoting profile options.

To change profile options, use the standard procedure outlined in the Oracle
Applications User’s Guide.
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4.3 Enabling the Cache for Oracle Quoting (HTML)

The Performance Framework in Oracle CRM Technology Foundation optimizes
application performance with a Java objects cache that is based in the middle tier.
Use of Oracle Quoting - HTML requires that you enable the cache. APIs will not
work properly if you do not.

1. Follow the instructions for Using Caches in the Oracle CRM Technology
Foundation Concepts and Procedures.

2. Make sure that Oracle Quoting is on the list of deployed applications.

For information on seeded caches in Oracle Quoting, see Appendix E, "Oracle
Quoting Seeded Caches". For information on enabling cache for the Quoting
application, see Oracle CRM Technology Foundation Concepts and Procedures.

4.3.1 Modifying the Cache Policy for a Particular Component (Optional)

You can modify the cache policy for Oracle Quoting using the procedure outlined in
Oracle CRM Technology Foundation Concepts and Procedures.

4.4 Assigning a Seeded Oracle Quoting Responsibility to a User
The following Oracle Quoting seeded responsibilities are available:
= Quoting Sales Agent (Forms)
= Quoting Sales Manager (Forms)

= Oracle HTML Quoting Sales Agent

Note: If you want to create your own responsibilities, assign the
menu QOT_QUOTE_ROOQOT to the responsibility.

To assign the Quoting HTML seeded responsibility (Oracle HTML Quoting Sales
Agent) to a user:

Login
Login to Oracle Forms.

Responsibility
System Administrator
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Prerequisites
The user must be set up as an application user.

Steps

1. Navigate to Security > User > Define.
2. Select Query by Example > Enter from the View menu.
The searchable fields turn blue.
3. Search for the user by entering a partial or complete name or user name.
4. Select Query by Example > Run from the View menu.
The form displays the record for the user.

5. In the Responsibilities tab, select Oracle HTML Quoting Sales Agent
from the Responsibility LOV.

6. Save your changes by selecting the save icon.

7. After assigning the responsibility to the user, you must ensure that the profile
JTE_PROFILE_DEFAULT_RESPONSIBILITY is set to 23410.

8. Ensure that the profile option JTF_PROFILE_DEFAULT_APPLICATION is set
to 880.

4.5 Setting up the Default Expiration Date
You can set the default quote expiration date so that quotes expires:
= Atthe end of a calendar period, e.g., quarter or month

= At the end of a fixed number of days

Expiration Date Based on Calendar Period

You can set the default quote expiration date so that quotes expire at the end of each
quarter, month or other calendar period. During setup, users can designate an
Oracle General Ledger (GL) calendar and period type from which the default
expiration date is calculated.

The Oracle General Ledger calendar selection is controlled by the profile option
ASO: Default Expiration Date GL Calendar. Available options include all
calendars set up in Oracle Accounts Receivables.
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The General Ledger period is controlled by the profile option ASO: Default
Expiration GL Period Type. Available options include all period types set up for
the selected GL calendar. For more information on these profile options, see
Appendix A, "Oracle Quoting Profile Options".

The expiration date is set to the last date of the selected period. For example, if
ASO: Default Expiration GL Calendar is set to Sample Calendar and ASO:
Default Expiration GL Period Type is set to Quarter. then the quote expiration date
defaults to the last day of the current quarter.

Expiration Date Based on a Fixed Number of Days

Alternatively, you can set the default quote expiration date so that quotes expire
after a fixed number of days. The fixed number of days defaults from the profile
option ASO: Quote Duration. For more information, see Appendix A, "Oracle
Quoting Profile Options".

Note: The value defined in ASO: Quote Duration is only used if
one or both of the GL Calendar profiles are null.

4.6 Setting up Overrideable Modifiers

If the profile ASO: Discounting Privilege is set to Full, users can manually override
prices. If you want users to have this ability, you must ensure that at least four
non-automatic modifiers are set up in Oracle Advanced Pricing. At the Header
level, there should be one discount and one surcharge with application methods of
percent or amount. At the Line Level, there should be one discount and one
surcharge set up with application methods of percent.

For information on setting up modifiers, refer to the latest version of the Oracle
Pricing User’s Guide.

4.7 Enabling or Disabling Sidebar Menu Functionality (HTML)

The sidebar menu in the HTML User Interface is not dynamically rendered. To
disable optional functionality, the related profile must be set to No. You can then
remove the relevant links from the sidebar menu. Note that the disabling of
functionality is global and affects all users. You must log out and bounce the
Apache server for changes to take effect.

You may remove the following links related to optional functionality:
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Approvals: menu query is QOT_SALES_INFORMATION

Sales Team: menu query is QOT_SALES_INFORMATION
Contracts: menu query is QOT_SALES_INFORMATION
Proposals: menu query is QOT_SALES_INFORMATION

Sales Supplement: menu query is QOT_OTHER_INFORMATION
Additional Information: menu query is QOT_INFORMATION

Login

Login to Oracle Forms

Responsibility
Applications Developer

Prerequisites
The profile option for the functionality to be disabled is set to No.

Steps

1.
2.
3.

Navigate to Applications > Menu. The Menus form displays.
From the View menu, select Query by Example > Enter.

Enter QOT_SALES_INFORMATION in the Menu field to display the Sales
Information menu details and disable Approvals, Sales Team and/or Contracts.

Enter QOT_OTHER_INFORMATION in the Menu field to display the Other
Information menu and disable Sales Supplement.

Enter QOT_INFORMATION in the Menu field to display the Quote
Information menu and disable the Additional Information link.

From the View menu, select Query by Example > Run. The page refreshes with
the line detail for the menu.

Select the line to disable. From the Edit menu, select Delete or place the cursor
in the Prompt field and clear it by selecting Edit > Clear > Field.

Select the save icon. A confirmation message displays with your request
identification. Note down this number so that you can track the relevant
concurrent program. When the program has completed, bounce the Apache
server. At your next login, the changes will be visible.
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4.8 Customizing the Lines Pages (HTML)
Oracle Quoting allows you to customize some elements of the Lines page. You can:
= Select which columns to display or hide
= Edit column labels
s Change column sequence

s Enable/disable line level actions and table buttons

Note: Once you change the seeded values, there is no way to
revert them back to the original definitions.

The following table shows a mapping of the column label to the attribute name.

Table 4-3 Column/Attribute Mapping

Column Name (Label) Attribute Name

Select QOT_SELECT

Product QOT_PRODUCT

Description QOT_DESCRIPTION
Quantity QOT_QUANTITY

uoOM QOT_UOM

Unit List Price QOT_UNIT_LIST_PRICE
Unit Adjustment Percent QOT_UNIT_ADJUST_PERCENT
Line Discount QOT_LINE_DISCOUNT

Unit Selling Price QOT_UNIT_SELLING_PRICE
Total Price QOT_TOTAL_PRICE

Charges QOT_CHARGES

Line Category QOT_LINE_CATEGORY

Line Type QOT_LINE_TYPE

Line (Line Number) QOT_LINE

Instance Name QOT_INSTANCE_NAME
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Table 4-3 Column/Attribute Mapping

Column Name (Label) Attribute Name

Custom Columns QOT_CUSTOM_COL1, QOT_CUSTOM_

COL2, QOT_CUSTOM_COL3

Tax Details QOT_TAX_DETAILS

4.8.1 Display/Hide Columns

You can choose which seeded columns to display or hide on the Lines page and in
the Lines section of the Overview page.

The following mandatory columns are always displayed:

Select
Product
Description
UOM
Quantity

The following seeded columns are optional:

Unit List Price
Unit Adjustment Percent

Line Discount

Note: If ASO: Calculate Price is set to Manual, the Line Discount
field is not shown even if it is enabled and the user has the ability to
perform price overrides.

Unit Selling Price
Total Price
Charges

Line Category
Line Type

Line Number
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s Instance Name
= Link to Customer Page

s Tax Details

To hide or display a seeded column:

Login

Login to Oracle Forms.

Responsibility

Applications Developer Common Modules

Prerequisites
None.

Steps

1.

2
3
4.
5
6

Navigate to Define Regions. The Define Regions form displays.
From the View menu, select Query by Example > Enter.

Enter QUOTELINEDETAILS in the Region ID field.

From the View menu, select Query by Example > Run.

Select Region Items. The Region Items form displays.

To hide a seeded column, deselect the Node Display checkbox for the
corresponding column. Selecting this checkbox displays the column.

Note: Although you can deselect the Node Display checkbox for
the mandatory columns, they will still display in the Quoting UL
You cannot disable these columns.

Select the save icon. A confirmation message displays.

Bounce web server. When you next login, the changes are visible.

4.8.2 Edit Column Labels

You can edit default text labels for each column.
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To revise column labels:

Login

Login to Oracle Forms.

Responsibility

Applications Developer Common Modules

Prerequisites
None

Steps

1.

2
3
4.
5
6

N

Navigate to Define Regions. The Define Regions form displays.
From the View menu, select Query by Example > Enter.

Enter QUOTELINEDETAILS in the Region ID column.

From the View menu, select Query by Example > Run.

Select Region Items. The Region Items form displays.

To change a column label, enter a new value in the Long Label field of the
corresponding line.

Select the save icon. A confirmation message displays.

Bounce web server. When you next login, the change is visible.

4.8.3 Edit Column Sequence

You can choose the order in which columns are displayed.

To edit column sequence:

Login
Login to Oracle Forms.

Responsibility

Applications Developer Common Modules
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Prerequisites
None

Steps
1. Navigate to Define Regions. The Define Regions form displays.

From the View menu, select Query by Example > Enter.
Enter QUOTELINEDETAILS in the Region ID column.

2

3

4. From the View menu, select Query by Example > Run.
5. Select Region Items. The Region Items form displays.
6

Change the values in the Sequence fields to rearrange columns. The lowest
sequence number is the first column displayed on the Lines page.

N

Select the save icon. A confirmation message displays.

8. Bounce web server. When you next login, the changes are visible.

4.8.4 Enable/Disable Line Level Actions or Table Level Buttons

You can choose to enable or disable line level actions and table level buttons. This
allows you to control the actions that a user can perform on the Lines page. See
Section 4.9, "Disabling Action Menus and Buttons (HTML)" for more information.

4.8.5 Customizing the Details Columns

You can customize the Details columns on the Lines page (HTML UI). These files
are hardcoded to the names:

= customLineDetails1.jsp
= customLineDetails2.jsp
= customLineDetails3.jsp

If you want to enable and use these columns, you must provide the jsp files, using
the filenames provided above.

Oracle quoting passes in two parameters for these columns:
»  qotHdrld—Quote header ID
= gotLnld—Quote line ID
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4.9 Disabling Action Menus and Buttons (HTML)

You can customize the Actions menus on the Lines and Overview pages. You can
also customize the buttons on the Lines page. Through customization, you
determine which options appear.

Note: If you want to add new lookup codes to the lookup types,
you must implement the logic. Oracle Quoting only supports the
seeded out-of-box values.

The menus are controlled by lookup codes. See Appendix B, "Seeded Lookup
Types" for more information.

Table 4-4 Lookup Types for Action Menus and Buttons

Lookup Type Description
ASO_LINE_ITEM_ Determines which actions appear in the Lines page Actions
ACTION menu.

ASO_LINE_ACTION  Determines which line level actions appear on the Lines page.

ASO_QUOTE_ACTION Determines which actions appear in the Overview page
Actions menu.

ASO_IB_ACTION_TYPES Determines which actions are available on the Search and
Select: Installed Base Product page.

ASO_PRODUCT_ Determines sources available when performing a product
SOURCE search.

ASO_IB_RELATIONSHIP_ Determines which Install Base relationship types are available.
TYPES

To enable or disable actions or buttons:

Login
Log in to Oracle Forms.

Responsibility
Quoting Sales Manager
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Prerequisites
The lookup code must be extensible.

Steps
1. Navigate to Setup > Quick Codes.

2. Select View > Query by Example > Enter.

3. Enter the lookup type in the Type field.

4. Select View > Query by Example > Run.
The record displays.

5. Locate the code to enable and select the Enabled checkbox.
To disable the lookup code, deselect the checkbox.

6. Save your work.

7. Bounce the web server. When you next log in, the change is visible.

4.10 Customizing the Overview Page (HTML)

By default, the Overview Page displays six sections:

= General Information

= Lines

= Grand Total

= Addresses

= Shipping

= Payment

With the exception of General Information, you can hide these sections.

The following table maps the section name with its attribute name.

Table 4-5 Section/Attribute Mapping

Section Name Attribute Name
Lines Section QOT_LINES
Grand Total Section QOT_GRAND_TOTAL
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Table 4-5 Section/Attribute Mapping

Section Name Attribute Name

Addresses Section QOT_ADDRESS
Shipping Section QOT_SHIPPING
Payment Section QOT_PAYMENT

To hide a section:

Login
Login to Oracle Forms.

Responsibility
Applications Developer Common Modules

Prerequisites

None

Steps

1. Navigate to Define Regions. The Define Regions form displays.

2. From the View menu, select Query by Example > Enter.

3. Enter QUOTEOVERVIEWSECTIONS in the Region ID column.

4. From the View menu, select Query by Example > Run.

5. Select Region Items. The Region Items form displays.

6. To hide a section, deselect the Node Display checkbox for the corresponding
section. Selecting this checkbox displays the section.

7. Select the save icon. A confirmation message displays.

8. Bounce web server. When you next login, the changes are visible.

4.11 Setting up Security

To enable security in Oracle Quoting, you must set the security profile options,
listed in Appendix A, "Oracle Quoting Profile Options".
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In addition, all users must be set up as valid Resources and assigned to sales
groups.

To view examples of how quoting security can be implemented, see Appendix C,
"Oracle Quoting Security Scenarios".

Note: Selecting a group for the Primary Sales Agent determines
where quote information shows up in Daily Business Close. For
example, a sales representative is part of Sales Group 1 and Sales
Group 2. If you want the sales representative’s stats to roll up to
Group Manager 1, you must select Sales Group 1 as the Primary
Sales Agent’s sales group for that representative.

4.11.1 Setting up Security Profile Options

For information on how to set profile options, see Section 4.2, "Setting System
Profile Options". For a complete list of the security profile options, see Section A.1,
"Current Profile Options".

4.11.2 Creating a Resource

If you want all users to have access to Oracle Quoting when security is enabled,
they must be set up as valid resources in Oracle Resource Manager.

When you create a resource you assign roles to the resource.

You can create a resource either by entering the user information into Resource
Manager or by importing an employee from Oracle Human Resources into
Resource Manager.

For information on creating a resource, refer to the Oracle CRM Application
Foundation Concepts and Procedures.

4.11.3 Setting Up Manager Roles

Oracle Quoting security uses roles to determine which resources are managers. A
manager must have an active role, of any role type, with the Manager flag checked.
In addition, a manager must have the appropriate role in the context of a group.

Managers have access to all quotes for the sales team they belong to. You can also
set up a manager to have access to all quotes for the sales teams to which their
subordinates belong.

Implementation Tasks for Oracle Quoting 4-21



Setting up Security

Table 4-6, "Role Type Example" lists the users, roles, roles attributes, and role types
for employees at a fictional company.

Table 4-6 Role Type Example

User Role Role Attribute Role Type

Bob Jones Regional Sales Manager Sales
Manager

Jane Adams District Sales Manager Sales
Manager

John Franklin Sales Agent Member Sales

Jennifer Moore Sales Agent Member Sales

For complete instructions on setting up roles, refer to the Oracle CRM Application
Foundation Concepts and Procedures.

4.11.4 Setting up a Group

Groups are used in Oracle Quoting security to determine the resource hierarchy.
Groups identify the subordinates under a particular manager. The resource with a
manager role in a group is considered the manager of all other resources in that
group and any child group.

A resource can belong to multiple groups. Only one resource with a manager role
should be in each group.

The following diagram demonstrates how the information in Table 4-6 is used to
infer a hierarchy in Oracle Quoting.
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Example 4-1 Sales Resource Manager Group Example

Group: West Region

Bob Jones
Regional Manager

¥ 3

Jane Adams Jahn Franklin
Sales Agent Sales Agent E
District Manager " District Manager '*:

¥

Jennifer Moore
Sales Agent

Group: Califfarnia Group: OregonsSeattle

Login

Login to Oracle Forms.

Responsibility

Resource Manager

Prerequisites
None

Steps

Note: If you are defining group hierarchies, set up the Parent
group first.

1. Set up a group based on the procedure defined in the Oracle CRM Application
Foundation Concepts and Procedures.

2. Make sure you select Sales and TeleSales from the Usage LOV.
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4.11.5 Verify Group Setup

To verify that you have set up your groups correctly:

Login

Login to Oracle Forms.

Responsibility

Resource Manager

Prerequisites
None

Steps

1. Navigate to Maintain Resources > Group Hierarchy.

The Group Hierarchy form displays.

Use the LOV to search for a resource’s name.

Select View.

The groups that the resource belongs to display in the Groups section.

Highlight a group to display its members.

N o a » 0 Db

Close the form.

4.12 Setting Up the Print Quote Functionality
Oracle Quoting uses Oracle Reports Server for Print Quote functionality.

The following steps are necessary for print quote to function properly. To set up
print quote:

1. Designate a value for the profile ICX: Report Server at the appropriate level.

A valid file with a standard file name, CGIcmd.dat, is located in the ORACLE_
HOME\REPORT®60 directory on the Web server machine. This file contains a
key map defined to simplify or hide parameters in your URL request. Enter this
key as the profile value of ICX: Report Server.

There should be an entry with the format <DBSID>_APPS_NO_DESFORMAT.
For example, if <DBSID> is SID01, then the profile ICX: Report Server must be
set to SID01_APPS_NO_DESFORMAT.
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Note: Ensure that the key you enter as the profile value does not
contain the clause desformat=HTML.

For more information, see Oracle Reports Developer - Publishing Reports.

2. Set the profile ASO: Print Quote Reports Directory to <$ASO_TOP>/reports
(specifying the absolute path, not the variable.) The Reports Server must have
access to this directory.

3. Set the variable REPSRV_NAME=Rep60_<SID> in your report server startup
script (adrepctt.sh).

4. Bounce web server.

4.12.1 Customizing the Print Quote Report

Currently, the base version of the print quote report populates the company address
information based on the current Organization ID. If you set up the company logo,
as detailed below, it will automatically be included in the report.

Note: To include tax details on your print quote report, set the
profile ASO: Show Line Level Tax Detail to Yes. To include the
Terms and Conditions from an executable quote, Oracle Sales
Contracts integration must be enabled.

Login
Log in to Oracle Applications.

Responsibility
Quoting Sales Manager

Prerequisites
None

Steps

1. Select Documents from the Navigator.

The Documents form opens.
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2. Select PrintQuote from the Category LOV.

3. Select File from the Source Data Type LOV.

The File Upload forms opens.

Browse for your file and select OK.

A window displays asking if your file uploaded successfully. Select Yes.

Save the document to the database.

N o a s

Find the Document ID for the document
a. Select Diagnostics > Examine from the Help menu.

b. In the Examine Field and Variable Value form, enter DOCUMENT _
HEADER for the Block and DOCUMENT_ID for the Field.

c. Note the value returned in the Value field.

Use this value to set the profile option ASO: Company Logo at the
appropriate level to display the company logo on your print quote report.

8. Customize the report title.

a. Two customizable FND messages are registered for the print quote report,
one for non-executable quotes and one for executable quotes. The message
names are:

* ASO_PQUOTE_EXEC_TITLE
* ASO_PQUOTE_NONEXEC_TITLE
9. Customize the disclaimer.

a. If a quote is non-executable, you can customize the disclaimer printed on
the bottom of the quote by changing the name of the ASO_PQUOTE_
DISCLAIMER message.

4.12.2 Adding or Disabling the Report Templates

You can disable the seeded report template, Default Print Layout, if necessary. You
can also add custom report templates.

To disable report templates:

Login

Log in to Oracle Forms.
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Responsibility
Quoting Sales Manager

Prerequisites

None

Steps

1. Select Quick Codes.

2. Select View > Query by Example > Enter.

3. Enter ASO_PQUOTE_TEMPLATES in the Type field.
To disable the seeded report template, enter ASOPQTEL.

4. Select View > Query by Example > Run.
The record displays.

5. Locate the code to disable and deselect the Enabled checkbox.
To re-enable the lookup code, select the checkbox.

6. Save your work.

7. Bounce the web server. When you next log in, the change is visible.

4.12.3 Adding New Print Quote Templates

You can add new templates to the ASO_PQUOTE_TEMPLATES lookup code. Once
you add templates to the lookup code, they appear as choices in the Template menu
on the Print Quote page.

To add new templates to the lookup:

1.

2
3.
4

Select Quick Codes.

Select View > Query by Example > Enter.
Enter Aso_PQUOTE_TEMPLATES in the Type field.
Select View > Query by Example > Run.

The record displays.

Place your cursor in the first available line.

Enter a code for the new template.
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7. Enter a meaning. This will appear in the Templates menu on the Print Quote
page.

8. Optionally, enter a description for the template.

9. Ensure that the Enabled box is checked.

10. Save your work.

11. Bounce the web server. When you next log in, the change is visible.

The new template will appear in the Templates menu on the Print Quote page.

Note: The file must be copied to the location specified in the
profile option ASO: Print Quote Reports Directory.

4.12.4 Product Categories

To show subtotals by product category in the quote print out, you must enter a
value in the profile option ASO: Category Set. ASO: Category Set is used in
Quoting - HTML when searching from the product catalog.

Note: The ASO: Category Set profile is optional. If this profile
option is not set it will use the default category set for the Order
Management functional area.

Product categories belong to category sets, which are defined in Oracle Inventory.
When you set up a category set in Inventory, you must ensure that products do not
belong to more than one product category.

Inclusion in more than one product category will affect subtotaling by product
category. For example, if a product belongs to category A and category B in the
same category set, the subtotals for each category will include the price of the
product, regardless of the fact that the product is only on the quote once.

Note: If a product is part of more than one category, the product
will show up as a duplicate in the product search. Oracle Quoting
does not expose Product categories in the Ul, so users will not
know that it is the same product in different categories.
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4.13 Setting up Manual Pricing and Tax Calculation Request Options

Out of the box, Oracle Quoting automatically prices a quote whenever a potential
price-affecting change is made. The pricing call also calculates taxes.

You can now manually price a quote, if the profile option ASO: Calculate Price is
set to Manual. You can also choose to calculate tax manually by setting ASO:
Calculate Tax to Manual. Depending on the setting of ASO: Enable Batch
Processing you can choose to price the quote interactively or through a batch
request.

Note: If ASO: Calculate Price is set to Manual, the Line Discount
field in the HTML Ul is not shown even if it is enabled and the user
has the ability to perform price overrides. (HTML only)

The following table shows suggested settings for the Pricing Option profile options,
based on user needs:

Table 4-7 Pricing Option Scenarios

ASO: Calculate ASO: Calculate Tax ASO: Enable Batch
Scenario Prices Setting Setting Processing Setting
Large number of Manual Manual Yes
quote lines, complex
pricing and tax setups
Large number of Manual Manual Yes
quote lines, simple
pricing and tax setups
Small number of Automatic Manual Yes
quote lines, simple
pricing setups,
complex tax setups
Small number of Automatic Automatic No
quote lines, simple
pricing and tax setups
Small number of Manual Automatic Yes

quote lines, complex,
pricing, simple tax
setups. Note: This
combination is not
recommended and
not supported.
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Table 4-7 Pricing Option Scenarios

ASO: Calculate ASO: Calculate Tax ASO: Enable Batch
Scenario Prices Setting Setting Processing Setting
Small number of Automatic Manual No

quote lines, simple
pricing setups, no tax
computation unless
requested.

4.13.1 Enabling Manual Pricing and Tax Requests

To enable manual pricing and tax requests, set the following profile options:

ASO: Calculate Price — Set to Manual, if the user does not want the quote to be
priced when a change is made to the quote. The user must manually price the
quote.

ASO: Calculate Tax — Set to Manual, if the user does not want tax to be calculated
when a change is made to the quote. The user must manually request tax
calculations for the quote.

Users can still manually compute price and tax even if these profile options are set
to Automatic.

Note: Setting ASO: Calculate Price to Automatic and ASO:
Calculate Tax to Manual is not recommended and not supported.
This is not a valid setup, and the tax calculation may be wrong.

4.14 Enabling interMedia Search
Oracle Quoting supports the use of interMedia search against the Product Catalog.

Ensure that both Oracle interMedia and Oracle Inventory are properly set up and
configured. The product search requires version 8.1.7 of the Oracle database with
the interMedia option installed. Product search also requires version 11i of the
Oracle Inventory schema.

Refer to the Oracle interMedia documentation for information on setting up
interMedia. Refer to the Oracle Inventory User’s Guide for information on setting up
Inventory.

To enable Intermedia search:

1. Set the following profile option:
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= ASO: Enable Intermedia Search
See Appendix A, "Oracle Quoting Profile Options" for more information.

2. Run the Concurrent Program iStore Search Insert

4.14.1 Running iStore Search Insert

Run this program after initially loading your products into Oracle Inventory. This
program should be run once, as a post install step during implementation.

However, you may need to rerun the program if one of the following conditions
occurs:

= You add multiple products that are not available in the search table
= You want to purge all data from the search table

The iStore Search Insert program collects product data from Inventory and inserts it
into the Oracle iStore search table IBE_CT_IMEDIA_SEARCH. While this program
is running, the product search will not work properly.

Note: You cannot have more than one Store Search Insert
concurrent request instance running at one time.

Once complete, you can search for products by name, part number, or description.

To run the iStore Search Insert program:

Login
Log in to Oracle Forms.

Responsibility
iStore Concurrent Programs Responsibility

Prerequisites
None

Steps
1. Select Single Request and select Ok.

2. Select iStore Search Insert from the Name LOV.
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3. Select Submit. Note the request ID.

4. You can view the progress of the request by selecting View Requests and
searching by Request ID.

4.14.2 Refreshing the Search Index

Administrators must refresh the interMedia search index, IBE_CT_IMEDIA_
SEARCH_IM, every time an existing product is changed or deleted, or a new
product is added.

Note: Before refreshing the index you must ensure that all triggers
related to Inventory are enabled.

You must have privileges to modify the index. Refresh the index through Oracle
Enterprise Manager or by executing the following command in SQL*Plus:

exec ctx ddl.sync_index(’'IBE_CT IMEDIA SEARCH’)

The changes appear in the product catalog.

4.15 Setting Up Account Creation Requirements for Quotes

Out of the box, Oracle Quoting does not require financial accounts—for customers
without any accounts—when creating a quote. Sales representatives can create
quotes for either prospects or customers. A prospect does not have a financial
account, while a customer has one or more financial accounts.

Oracle Quoting allows you to determine at which point an account is created. For
more information on the following profile options, see Appendix A, "Oracle
Quoting Profile Options".

Account creation is based on the following profile options:

»  ASO: Auto Account Creation—Determines when an account should be
automatically created.

Depending on how you set the profile option ASO: Auto Account Creation, you
can set up account restriction in the following ways:

= Always create accounts—Accounts are created for customers when the quote is
saved.

4-32 Oracle Quoting Implementation Guide



Setting Up Account Creation Requirements for Quotes

= Create accounts as necessary—Accounts are created only when a quote is web
published, a non-standard contract is created, or when a quote is converted into
an order.

= Create accounts only when Place Order—Accounts are created only when the
quote is converted into an order.

Scenarios

The following table shows the behavior of Oracle Quoting based on the setting of
this profile option.

Table 4-8 Oracle Quoting Behavior Based on the Account Profile Option

Initiate
Create Select Non-Stand
Profile Option Create Select Ship-To/B Ship-To/Bi Web ard Order
Setting Sold-To Sold-To ill-To II-To Publishing Contract Conversion
ASO: Auto Create Create Create Create Create account Create Create
Account account account if  account accountif forall account for account for
Creation set to customer customer  customersin  all all
Always has none hasnone  quote without customers customers
account in quote in quote
without without
account account
ASO: Auto Do not Do not Do not Do not Create account Create Create
Account create create create create for any account for account for
Creation setto  account account account account customersin  any any
As Required quote without customers customers
account in quote in quote
without without
account account
ASO: Auto Do not Do not Do not Do not Throw error if Throw Create
Account create create create create any customers error ifany account for
Creation setto  account account account account on quote do customers  all
Place Order not have on quote  customers
accounts do not on quote
have without an

accounts account

If ASO: Auto Account Creation is set to Always, an account is created for each
party on the quote (that does not have an account) when the user saves a quote. In
addition, each time a new customer is created, as account is created as well.
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If ASO: Auto Account Creation is set to As Required, an account is created for each
customer on the quote (that does not have an account) when the quote is:

= Web published
= A non-standard contract is initiated
s The quote is converted into an order.

If ASO: Auto Account Creation is set to Place Order, an account is created for each
customer on the quote without an account when the quote is converted into an
order.

4.16 Setting up Proposals

Oracle Quoting integrates with Oracle Proposals to provide proposal capabilities.
With Oracle Proposals, Quoting users can create and email full proposals, including
quote information, and other customized collateral to the customer.

To enable use of Proposals, ensure that the Proposals link is shown in the Quote
Overview sidebar menu.

s Menu Name: QOT_SALES_INFORMATION
= Prompt: Proposals

For instructions on enabling a link in the sidebar menu, see Section 4.7, "Enabling or
Disabling Sidebar Menu Functionality (HTML)".

4.17 Setting up Web Publishing Functionality

Web publishing functionality allows sales representatives to publish quotes to
customers through Oracle iStore specialty stores.

4.17.1 Enabling Web Publishing

Use of web publishing functionality in Oracle Quoting is controlled by the profile
option ASO: Enable Web Publishing. For more information on Oracle Quoting
profile options for web publishing, see Section A.1, "Current Profile Options".

You must also set the profile IBE: iStore Non Secure URL to iStore URL at the
application level. See Section A.9, "Oracle iStore Profile Options".
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Note: If you are using the HTML Ul and are integrated with
Oracle Sales Online, you must set IBE: iStore Non Secure URL at
the Application level for the application Oracle Field Sales. If you
are not integrated with OSO, the profile should be set at the
Application level for Oracle Quoting.

4.17.2 Setting Up a Specialty Store

Web Publishing functionality requires the setup of specialty stores in Oracle iStore.
Customers can access published quotes through these Specialty Stores. For
information on setting up specialty stores, refer to the Oracle iStore Implementation
Guide.

Note: Oracle Quoting only supports Specialty Stores that have no
access restrictions.

4.18 Setting up Approvals

For information on setting up Approvals functionality, refer to Chapter 7,
"Integrating Oracle Quoting With Oracle Approvals Management".

4.19 Setting up Contracts

For information on setting up contracts functionality, refer to Chapter 8, "Integrating
Oracle Quoting With Oracle Sales Contracts".

4.20 Setting Up Credit Check Functionality

Oracle Quoting allows the user to determine the credit worthiness of a customer
before the quote is converted into an order. The profile option ASO: Enable Credit
Check determines if credit checks can be performed. See Appendix A, "Oracle
Quoting Profile Options" for more information.

Oracle Quoting provides a public API for credit checking: ASO_CREDIT_CHECK_
PUB.CREDIT_CHECK. For more information on the credit check AP]I, refer to the
Oracle Order Capture Foundation API Reference Manual. The following information is
mandatory for the public API:

s Header level bill-to customer, bill-to account, and bill-to address
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Credit Check Rule
Quote Total

Quote Currency

The credit check API consists of two sections:

Internal credit check—This is based on the Oracle Order Management public
APL

External credit check—The public credit checking API in Oracle Quoting
provides a pre-hook and post-hook for which customers can write configurable
code. The pre-hook is executed prior to the internal credit check and the
post-hook is executed after the internal credit check. Quoting customers can use
these hooks to invoke the external credit checking.

4.20.1 Internal Credit Check

Oracle Quoting supports the use of internal credit checks. Internal Credit Checks
are based on:

Transaction data in the quote

Historic transaction data in Oracle Order Management and Oracle Receivables

These credit checks are performed by the Oracle Order Management public API
OE_EXTERNAL CREDIT PUB.CHECK CREDIT. For more information, see the
Oracle Order Management Suite Implementation Manual.

To perform internal credit checks, you must:

Ensure that the customer is enabled for credit checks.

You must enable the Credit Check flag in the Profile Transactions tab for the
customer in Oracle Receivables. See the Oracle Receivables User Guide for more
information.

Set credit limits.

In Oracle Receivables, you can set up overall credit limits and order credit
limits. These limits can be set on two levels: customer and site. Site level, which
pertains to the bill-to address, takes precedence over the customer level limit, if
both are set. See the Oracle Receivables User Guide for more information.

Define credit check rules in Oracle Order Management.

Define credit checking rules to help determine credit worthiness of customers
and to specify if freight and special charges are included during credit checks.
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4.20.1.1 Defining Credit Check Rules

You designate the credit check rule used for performing credit checks in the profile
option ASO: Credit Check Rule. This is an optional profile, but if it is not set, users
cannot perform internal credit checks. See Section A, "Oracle Quoting Profile
Options" for more information.

The credit check rule definition allows you to determine if freight and special
charges are included during credit checks. The quote total passed to Oracle Order
Management is based on the setting of the credit check rule. There are two flags
available when you set up a credit check rule:

= Include Freight and Special Charges — If set, the quote total passed to the API
includes shipping and freight charges. If not set, the quote total excludes
shipping charges and freight charges.

s Include Tax — If set, the quote total passed to the API includes the total tax
amount. If not set, the quote total excludes tax.

Login
Login to Oracle Forms.

Responsibility
Order Management Super User

Prerequisites
None

Steps
1. Follow the procedure described in the Oracle Order Management Implementation
Guide for complete information on defining credit check rules.

Note: Credit Check Rules must be at the order level, not the line
level. When setting up your credit check rules, ensure that each rule
has a Credit Check Level of Sales Order. Ensure that the Check
Item Categories checkbox is not checked for the credit check rule.
Also, the Send Hold Notifications flag must not be enabled for the
credit check rule.
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2. To include the shipping and freight charges on the quote and on uninvoiced
orders in the credit check calculation, you must select the Freight and Special
Charges checkbox.

3. To include the tax for the quote and uninvoiced orders in the credit check
calculation, you must select the Include Tax checkbox.

4.20.2 External Credit Check

External credit checks are configurable by the application developer and allow
users to make calls to non-Oracle applications. The credit check can be configured
by writing code for the pre-hook and post-hook in the Quoting public API, ASO_
CREDIT_CHECK_ PUB.CREDIT_CHECK. For more information on the credit
check AP], refer to the Oracle Order Capture Foundation API Reference Manual. The
pre-hook is executed prior to the internal credit check and the post-hook is executed
after the internal credit check. Oracle Quoting customers can use these hooks to
invoke the external credit checking.

For user hooks to work properly, the following SQL scripts must run:

= asocruhk.sql — The Populate Script populates data into the JTF_USER_
HOOKS table. This script is run automatically.

= asoenuhk.sql — The Enabling Script enables or disables the user hook based on
the parameter passed. You must execute this script.

Populate Script
This script populates the following user hooks in the JTF_USER_HOOKS table:

s Customer Pre Hook

s Customer Post Hook

Enabling Script

This script updates the Execute flag in the JTF_USER_HOOKS table for a particular
hook, thereby enabling or disabling the user hook.

Parameters
This script accepts the following parameters:

Package Name — Name of the package that contains the user hook calls: ASO_
CREDIT_CHECK_PUB.
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API Name — Name of the procedure within the package which contains the user
hook calls: CREDIT_CHECK.

Processing Type — The following processing types are supported: pre and post.
Valid values are B (pre processing) or A (post processing).

Hook Type — The following type is supported: Customer. Valid value is C
(customer).

Enabled Flag — Enabling user hooks. Valid values are Y or N.

4.20.3 Implementing User Hooks

To implement user hooks, you must:

1. Populate the JTF_USER_HOOKS table
2. Enable User Hooks

3. Disable User Hooks

4.20.3.1 Populating the JTF_USER_HOOKS table

The Populate script automatically runs against the database, when you install the
patch, and populates the JTF_USER_HOOKS table.

4.20.3.2 Enabling User Hooks

To enable user hooks:

1. Run the Enabling script against the database. This script enables one user hook
at a time. It is only necessary to run this script to enable the desired hook.

2. Enter each parameter. For enabling user hooks with the ENABLE parameter, the
value should be Y.

3. You must implement the hook package when the corresponding hook is
enabled.

4.20.3.3 Disabling User Hooks

To disable user hooks:

1. Run the Enabling script against the database. This script disables one user hook
at a time. It is only necessary to run this script to disable the desired hook.

2. Enter each parameter. For disabling the user hook with the ENABLE parameter,
the value should be N.
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4.21 Setting up Sales Supplement Templates

Sales Supplement allows the capture of additional quote-specific information that is
not passed into Oracle Order Management.

Once setup is complete in the Forms U], Sales Supplement information is accessible
to sales representatives in the HTML Ul You cannot view Sales Supplement
information in the Forms UL Sales Supplement functionality is enabled using the
profile option ASO: Enable Sales Supplement. For more information on this and
other profile options, see Appendix A, "Oracle Quoting Profile Options".

The basic hierarchy of a Sales Supplement template is as follows:

A Template contains one or more sections. Within each section is a
component-response set. For example, if the template is a questionnaire, within
each section there is a related set of questions and predefined responses.

Note: You cannot delete templates, sections, components, or
responses.

Component type and Response type are defined in the context of a
component-response set. Although there are four component types, only a
component type of Question can have associated responses. There are five types of
responses:

= Predefined Responses — Supports user selection from predefined text
s Text — Supports end user input

s Currency — Supports end user input

= Number — Supports end user input

= Date — Supports end user input

The response type Predefined Responses is associated with Presentation Styles.
There are four Presentation Styles:

= List of Values

» List of Values With Blank
= Radio Group

»  Checkbox
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Note: You can specify a default value along with the presentation
style. The default value is optional except when the presentation
style is List of Values.

Default Value and Presentation Style are defined in the context of a section -
component mapping to allow use of the same component - response set in different
sections of one or more templates.

The following diagram shows the sales supplement structure and process flow.

"Sales Supplement Structure”™

Default
Predefined (o Predefined
R Responses
esponse
Component R T
(Type - Mote/ esponses (Type
ﬁ Header/Footer) - Predefined)
N Sectons Presentation
Style

Responses (Type
; Component - Number/Date/

(Type - Question) Currency/Text)

4

S Instructions

Login

Log in to Oracle Forms.
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Responsibility
Quoting Sales Manager

Prerequisites

In order for HTML UI users to view the information you set up in this form, you
must enable Sales Supplement by setting the profile option ASO: Enable Sales
Supplement to Yes.

Steps

Note: Save your work in each tab.

1. Navigate to Setup Sales Supplement Data.

In the Responses tab, enter a name for the response.
Optionally, enter a description for the response and Save.
In the Components tab, enter a name for the component.

Optionally, enter a description for the component.

o g 0 b

Use the LOV to select a component type.

Available component types are:

= Note
s Header
s Footer

s Question

7. If you selected Question as the Component Type, select a Response Type from
the LOV.

The Response Type field is enabled only if the Type is Question. The following
response types are available: Text, Number, Date, Currency, and Predefined
Responses. The Responses are enabled only if the Component Type is Question
and Response Type is Predefined.

a. Enter a sequence in the Responses.
b. Select a response from the LOV and Save the component.

The LOV lists all predefined responses.
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10.
1.
12.

13.

14.
15.
16.
17.
18.
19.

Optionally, enter instructions for the component.
In the Sections tab, enter a name for the section.
Optionally, enter a description for the section.
Enter a sequence for the section component.

Select a component from the LOV.

Note: If you select a component type of Question that has
predefined responses, you can designate a presentation style such
as a Radio Group, Checkbox, List of Values, or List of Value with
Blank.

Optionally, select a Default Value. Default value is required for the Presentation
Style list of values.

Save the section.

In the Template tab, enter a name for the sales supplement template.
Optionally, enter a description for the template.

Enter the display sequence for the template sections.

Select a section from the LOV.

Save the template.

Note: You must manually query each tab. The tabs are not
automatically queried. Each tab behaves as a standalone tab.
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4.22 Modifying Seeded Lookup Types

For a complete list of the seeded lookup types in Oracle Quoting, refer to
Appendix B, "Seeded Lookup Types".

To modify the seeded Lookup Types (QuickCodes):

Login
Log in to Oracle Forms.

Responsibility
Quoting Sales Manager

Prerequisites
None

Steps

1.

Navigate to Setup > Quick Codes.
The Oracle Quoting Lookups window opens.
From the View menu, select Query by Example > Run.

The window displays all Oracle Quoting lookup types. Use the down arrow key
to scroll through the list.

To search for all Oracle Quoting lookup types, enter a percent sign (wildcard) in
the in the Type field.

To search for a specific lookup type, enter the lookup type name in the Type
field.

From the View menu, select Query by Example > Run.

All Oracle Quoting lookup types display in the form. Use the down arrow key
to scroll through the list.
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4.23 Creating Additional Attachments Document Categories

Oracle Quoting currently supports one document category, Miscellaneous. This is
the default for the Document Category field when you create a new attachment.
You can create additional categories as needed.

For more information on setting up attachments, refer to the latest release of the
Oracle Application Developer’s Guide. For more information on using attachments.
refer to Oracle Quoting User Guide or Oracle Applications User’s Guide.

4.24 Defining Descriptive Flexfield Information

Descriptive flexfields are customizable, blank fields on the Oracle Quoting form that
allow the application developer to enter additional fields as needed. A descriptive
flexfield is composed of segments, each of which has a prompt and may have either
a valid set of values or data entered by the user.

In the Forms Ul, descriptive flexfields are located in the main Quoting form, and in
the Pricing view of the Quote Lines tab.

In the HTML UI, header level flexfields are located in the sidebar menu option
Additional Information. Line level flexfields are accessed through the Lines page
Action menu item Specify Additional Information. They are represented by an
unnamed field enclosed in brackets.

For information on setting up and modifying flexfields, refer to the Oracle
Applications Flexfield Guide.

Note: In order for flexfields to exist on the quote once it becomes
an order, the application developer must set up the flexfields
identically in Oracle Order Management. Repeat this procedure in
the Oracle Order Management application to carry flexfields from
quote to order.

4.25 Notes from Opportunities

Notes functionality is owned by Oracle JTT. Note types, used to categorize notes,
can be mapped to one or more source objects. For example, a note type can be
mapped to the source object Sales Opportunity, or Sales Lead. If a note type is
mapped to a specific source object, it is available only from the source object(s). If a
note type is not mapped to any particular source objects, it is available from all
source objects.
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Notes created in Oracle Sales Online or Oracle TeleSales may have different note
types because they may be mapped to a source object specific to opportunities.
When a salesrep creates a quote from an opportunity, notes should only be copied if
they meet at least one of the following criteria:

= Note type is available to all possible sources—The note type was not mapped to
a particular object.

= Note type is available to the seeded source object Quoting—The CRM
Administrator mapped the note type to the Quoting source object (ASO_
QUOTE).

For information on setting up and mapping note types, see the Oracle Application
Foundation Implementation Guide.

4.25.1 Tasks From Opportunities (HTML only)

When sales representatives create tasks, they must specify task types. Task types are
used to categorize tasks. JTT tasks functionality allows administrators to created
task types as necessary.

Administrators have the option to map task types to source objects. For example, a
task type can be mapped to the source object Sales Opportunity or Sales Lead. If a
task type is mapped to a specific source object, it is available only from the source
object(s). If a task type is not mapped to any particular source objects, it is available
from all source objects.

Tasks created in Oracle Sales Online may have different task types because they
may be mapped to a source object specific to opportunities. When a salesrep creates
a quote from an opportunity, tasks should only be copied if they meet at least one of
the following criteria:

»  Task type is available to all possible sources—The task type was not mapped to
a particular source object.

»  Task type is available to the seeded source object Quoting—The CRM
Administrator mapped the task type to the Quoting source object (ASO_
QUOTE).

For information on setting up and mapping task types, see the Oracle Application
Foundation Implementation Guide.
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Post Implementation Tasks

This section of the Oracle Quoting Implementation Guide contains the following
chapters:

= Chapter 5, "Verify the Implementation"
= Chapter 6, "Diagnostics and Troubleshooting"






O

Verify the Implementation

5.1 Oracle Quoting Implementation Verification Tasks

This chapter contains material useful in verifying the implementation of Oracle
Quoting.

After you complete the configuration and setup of Oracle Quoting, verify that you
can perform the following tasks.

5.1.1 Verification Task List

You must be able to complete these tasks successfully, or Oracle Quoting will not
work properly.

For information on the procedures necessary to perform these tasks, see Oracle
Quoting User Guide.

1. Create a complex quote.

Create a new customer for your quote.
Add and configure a model item.
During the checkout process, create a new contact for the customer.

During the checkout process, create a shipping or billing address for the
customer.

2. Submit the order.

If the submission process was a success, you receive confirmation from Oracle
Order Management.
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Diagnostics and Troubleshooting

This chapter contains material useful in diagnosing and troubleshooting the
implementation of Oracle Quoting.

Overview of Diagnostics and Troubleshooting
Frequently Asked Questions (FAQs)
Common Errors

How to Set up Debugging when Logging an iTar to Send to Support
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6.1 Overview of Diagnostics and Troubleshooting

The following sections provide assistance if you are having problems using Oracle
Quoting. In addition, you can find additional FAQs and errors on Oracle MetaLink.

Note: The Oracle CRM Diagnostic Tool is useful in pinpointing
problems with the setup and configuration of many CRM modules.
It is available through the CRM System Administration Console.

6.2 Frequently Asked Questions (FAQs)

This section contains FAQs on recurrent issues encountered in Oracle Quoting.

6.2.1 Order Feedback Queue Frequently Asked Questions (FAQs)

Question: The queue table ASO_ORDER_FEEDBACK_T is growing in size. How
do I stop it?

Answer: Log in to Oracle Forms using the Oracle Quoting Sales Manager
responsibility and navigate to QuickCodes. Delete or disable all the lookup entries
for lookup ASO_ORDER_FEEDBACK_CRM_APPS.

Question: The install base concurrent program is reading the rows from the queue
table. Why are these rows still there?

Answer: The messages are being removed by the Install Base program, but new
messages that are queuing for different consumers are not being dequeued or
inspected at all. This happens if there is a registered consumer in the ASO lookup
(ASO_ORDER_FEEDBACK_CRM_APPS) for which there is no dequeueing
program. Delete or disable all the lookup entries except for Install Base for lookup
ASO_ORDER_FEEDBACK_CRM_APPS in the QuickCodes form.

Question: The queue table is growing in size. I do not have any CRM applications
that depend on it. How can I remove all the rows in the table?

Answer: Perform the following tasks:

= Login to Oracle Forms using the Oracle Quoting Sales Manager responsibility
and navigate to QuickCodes. Delete or disable all the lookup entries for lookup
ASO_ORDER_FEEDBACK_CRM_APPS.
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= Apply ARU bug 1449198 which drops the queue table and recreates it.

Question: The Install Base Interface Concurrent Program completes with an error
status with a fatal exception from the:

ASO ORDER FEEDBACK GET PVT API. FND AS UNEXPECTED ERROR (PKG NAME=ASO ORDER
FEEDBACK_GET_PVT) (PROCEDURE_NAME:GET_NOTICE) (ERROR_TEXT:ORA—OOGOO: internal
error code, arguments: [koxsi2szl], [131, [1, (I, [I, (1, [1, [1).

What does this mean?

Answer: This error occurs because of bug 1424051 in RDBMS. Customers have to
apply a patch to avoid this problem. The only workaround is to drop the rows in
the table. For this, a standalone ARU 1449198 needs to be applied which will drop
and recreate the queue.

Question: Bug 1816891: Placing an order in OM or OC throws the error:

FND AS UNEXPECTED ERROR (PKG NAME=ASO ORDER FEEDBACK UPDATE PVT) (PROCEDURE NAME
=UPDATE_NOTICE) (ERROR_TEXT=ORA-25207: enqueue failed, queue ASO.ASO OF Q is
disabled from enqueueing) .

Why does this happen?

Answer: This error occurs because the queue is not enabled for enqueuing. The
following SQL commands need to be run as APPS user to enable the queue for
enqueuing and dequeuing:

execute dbms_agadm.start queue ('ASO.ASO OF Q', TRUE, TRUE);
execute dbms_agadm.start queue ('ASO.ASO OF Q E', FALSE,TRUE);
execute dbms_agadm.start queue ('ASO.ASO OF EXCP_Q', TRUE, TRUE);
execute dbms_agadm.start_queue ('ASO.ASO_OF_EXCP_Q E', FALSE,TRUE);

Question: Bug 1897375: Placing an order in OM or OC throws an error: 100501 -
non-Oracle Exception. The debug file shows the error.

FND AS UNEXPECTED ERROR (PKG NAME=ASO ORDER FEEDBACK UPDATE PVT) (PROCEDURE
NAME=UPDATE NOTICE) (ERROR_TEXT=ORA-06502: PL/SQL: numeric or value error:
character to number conversion error).

Why does this happen?

Answer: The error occurs because the profile value ASO: Order Feedback Queue
Retention Time was set to a character string.
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The profile value ASO: Order Feedback Queue Retention Time is used to
determine how long the message is retained in the Order Feedback Queue. Set the
profile value to null (never expires) or a large number (timed in seconds).

Question: Is there a way to delete unnecessary records from ASO_ORDER _
FEEDBACK_T table?

Answer: You need to run the script asoclofq.sql from $ASO_TOP /patch/115/sql
area. This script requires the input parameter: application_short_name. The
application_short_name has to match the lookup entry defined in the ASO lookup
ASO_ORDER_FEEDBACK_CRM_APPS. This script will remove all records in the
table for the application specified.

6.2.2 Can you set up approvals at the line level?

Question: We require approval at the quote line level because we have different
approval levels for different price limits. If the lines have different prices, how can
we approach this scenario as the quote needs to be approved by different
approvers? Can we setup rules that designate that an approver can only approve
lines under his limit?

Answer: Yes. You can specify that a rule evaluate the quote at the header or line
level. In this particular case, the rule is set up to evaluate the line level. Therefore,
each line is evaluated and approvers are determined accordingly. The approvers for
each line are merged and ranked in hierarchical order to determine the candidate
list of approvers for all lines.

We would set up this scenario as follows:
= Level 1 has authority to approve discounts up to 10%
= Level 2 has authority to approve discounts up to 20%

A quote has one line with a 5% discount and a second line with 15% discount. The
quote would be sent to both Level 1 and Level 2 for approval.

6.2.3 Why is some Opportunity line information not carried over to Oracle Quoting
when a new quote is created?

Question: When a customer creates a quote from an Opportunity, why isn’t the line
information from the Opportunity copied into the new quote?
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Answer: Lines default from the opportunity into the quote based on the following
conditions. If the following conditions are not met, the quote is created without the
line(s).

s If a product does not have a unit of measure (UOM) defined, the
Opportunity-Quote API defaults to the Primary UOM_CODE from Inventory. If
the Primary UOM_CODE is not defined in Inventory, the application shows an
error message and then drops the line.

»  If there is any pricing error before creating the quote, the application shows an
error message and then drops the line.

s If a product in the Opportunity is non-customer orderable, the application
shows an error message and then drops the line.

s If a product in the opportunity is a service item, the application shows an error
message and then drops the item. The opportunity schema does not support the
information required to create service items.

=  If the opportunity contains a model product and there is no configurable Ul
defined for that model, the application shows an error message and then drops
the line.

s Ifa product in the opportunity has an invalid quantity, the application shows an
error message and then drops the line. We are calling the Inventory API to
validate the quantity.

6.3 Common Errors

This section contains information on some of the common errors associated with
Oracle Quoting.

If you have any problems using Oracle Quoting, first:
= Make sure that Oracle Quoting is fully installed
= Recompile the server objects

= After recompiling server objects, regenerate forms and libraries

6.3.1 Error when Build Sourcing Rules

If you receive an error when you run Build Attribute Mapping Rules in Oracle
Pricing Manager, you must bounce your middle tier.
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Build Attribute Mapping Rules is a concurrent program that must be run before a
new qualifier or source pricing attribute is used for the first time. For more
information on the Build Attribute Mapping Rules process, refer to the Oracle
Pricing User’s Guide.

6.3.2 Unable to Place Order Without a Sold-to Contact

Problem:

The sold-to customer, Customer A, does not have a contact on the quote. A different
customer, Customer B, and a contact for that customer, Contact B, were entered in
either the Bill To or Ship To tab.

When you try to submit the quote, you get the following errors:
= Error message from Order Management
= Validation failed for the field - Contact
s Thereis an error in order submission
Fix:
This error occurs because OM defaulting rules for the Contact field state that if this
field is blank, the value should default from the bill-to contact field or ship-to

contact field. An error results because you cannot enter a contact from a different
customer into the related Contact field.

To fix this problem, either:
s Enter a sold-to contact
OR

= Go into Oracle Order Management and delete the defaulting rules for the
Contact field.

6.3.3 No Workflow Assigned to This Line Type Error

Problem:
Customer receives an error when attempting to add a line type to a quote.
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Fix:

Assign or verify that workflow is assigned to the Transaction Type selected in the
ASO: Default Order Type profile option. This procedure is performed in Forms
using the Order Management responsibility. See Section 2.4.8, "Setting up Oracle
Order Management" for more information.

6.3.4 Quote Status Remains Contract Pending When Contract is Canceled

Problem:

When user cancels a contract, the quote status does not change to Contract
Canceled. It stays in Contract Pending status.

Fix:
Run the Workflow Background Process as described in Section 8.1.4, "Run
background processes".

6.3.5 Report Output is Not Formatted Properly

Problem:
When attempting to Create Printable Quote, the user receives the following error:

Error: The requested URL was not found, or cannot be served at this time.

Oracle Reports Server CGI - Key "REP60_Database SID" is unrecognized.
Possible causes: bad URL syntax; key in URL was not found in key map file.

Fix:
1. Designate a value for the profile ICX: Report Server.

A valid file with a standard file name, cgicmd.dat, is located in the ORACLE_
HOMEN\REPORT60 directory on the Web server machine. This file contains a
key map defined to simplify or hide parameters in your URL request. Enter this
key as profile value of ICX: Report Server.

For more information, see Oracle Reports Developer - Publishing Reports.

2. Set the profile ASO: Print Quote Reports Directory to <content of $ASO_
TOP> /reports (specifying the absolute path, not the variable.)

3. Bounce the web server.
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6.3.6 Can Only Generate Quote Print Outs in HTML Format

Problem:
When printing quotes from Oracle Quoting, quotes will only print in HTML format.

Fix:

Remove desformat=html from the @ <SID> APPS:server=Rep60 <sid>
userid=APPS/<APPS user passwd>@<sid> destype=cache
desformat=html line in the CGlcmd.dat file.

6.3.7 Note Types for Quote are Different Than Opportunity

Problem:

When you create an opportunity and add a note, then convert the opportunity into
a quote, the note type choices are different. The note from the opportunity appears
in the quote, but the note type list is different.

Fix:

Oracle Quoting and Oracle TeleSales or Oracle Sales Online do not necessarily share
note types. Therefore, if you are integrating with Oracle TeleSales or Oracle Sales
Online and you want Oracle Quoting to have the same note types, you must map
the note types to Quoting.

Steps
1. Follow the instructions in the Oracle CRM Application Foundation Implementation
Guide for mapping note types to source.

2. In the Source field, enter Quoting.

3. Inthe Note Type field, select the note type you want to show up in Oracle
Quoting.

4. Repeat this procedure for all note types you want to appear in Quoting.
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6.3.8 No ATP Information Shows up in the Availability Form

Problem:

When user performs an availability check for items in the quote, there is no
availability information.

Fix:

If availability information is missing for all items, check that you properly set up:
= Option settings

= ATP Rule Settings

= ATP Rule to Organization assignments

If availability information is missing for some items, then ATP may not be enabled
for these items. Check the ATP setup for items and BOM items.

If availability information is missing for configured items and their components,
ATP may not be enabled for Bills of Material structure for the models. Check the
ATP setup for BOM models.

6.4 How to Set up Debugging when Logging an iTar to Send to Support

To set up debugging in Oracle Quoting:

6.4.1 Setting Up Debug File Location

The debug file helps Oracle debug the cause of your problem. This is mandatory for
all bugs logged against Oracle Quoting Patchset E or later.

Steps
1. Ensure that the Oracle Order Management profile OM: Debug Log Directory is
set.

2. The profile value must be one of the directories listed in the utl_file_dir
parameter in the init.ora file.

6.4.2 How to Use Debugger From the Oracle Quoting Main Form
To employ the debugger in the main Oracle Quoting form:
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Steps
1. Check ASO Debug under Tools menu.

Check that the profile ASO: Enable ASO Debug is set to Yes at the user level.
Check that the profile OM: Debug Level is set to 10 at the site level.

2

3

4. The profile QP: Debug must to be set to Yes.

5. The profile Tax: Debug Flag must be set to Yes.
6

The profile Tax: Debug File Directory must be set and the value must match
one of the directories mentioned in utl_file_dir_param in the init.ora file.

N

Note the debug file name and location.
8. Execute the steps necessary to reproduce the bug.

The debug file is generated in the directory specified in the Oracle Order
Management profile OM: Debug Log Directory.

6.4.3 How to Use Debugger in SQL Scripts
Use the following procedure to employ the debugger in SQL scripts.

Steps
1. Use the following statements at the start of your SQL script:

aso_debug pub.initialize;
aso_debug pub.debug on;
aso_debug pub.setdebuglevel (10) ;
1 file := aso_debug pub.set debug mode ('FILE') ;
doms_output.put line('File :'||1 file);

2. Execute the SQL script to reproduce the bug.
3. Note the debug file name and location.

4. The debug file is generated in the directory specified in the Oracle Order
Management profile OE_DEBUG_LOG_DIRECTORY.

6-10 Oracle Quoting Implementation Guide



PartlV

Integration of Oracle Products

This section of the Oracle Quoting Implementation Guide contains the following
chapters:

s Chapter 7, "Integrating Oracle Quoting With Oracle Approvals Management"
= Chapter 8, "Integrating Oracle Quoting With Oracle Sales Contracts"
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Integrating Oracle Quoting With Oracle
Approvals Management

This section contains information on integrating with Oracle Approvals
Management and setting up approvals functionality.

Setting Up Approvals Functionality
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7.1 Setting Up Approvals Functionality

If you choose to implement the Approvals functionality there are a number of setup
steps you must complete.

1.

Set up all Approvals quote statuses.

Oracle Quoting requires that you set up additional quote status transitions if
you choose to use Approvals. You must set up the following transition statuses:

= Draft to Approval Pending

= Approved to Order Submitted

= Approval Rejected to Approval Pending
= Approval Canceled to Approval Pending
= Approved to Draft

Set the Approvals profile options.

For information on the Approvals profile options, refer to Appendix A, "Oracle
Quoting Profile Options".

Set up conditions and rules in Oracle Approvals Management (OAM).

A rule requiring approval is defined using attributes, conditions, and approval
type. Attributes are used to define Conditions. One or more conditions and an
approval type constitute a rule.

The seeded attributes for Quoting are available in Table D, "Seeded Attributes
in Oracle Approvals Management (OAM)".

For information on setting up rules and conditions in OAM refer to the Oracle
Approvals Management Implementation Guide.

Set up the default roles and responsibilities for user types.
Oracle iStore requires use of the following user types:

»  Business User

= End User

You must define the default roles and responsibility for these role types through
Oracle CRM Foundation’s User Management framework. For information refer
to the latest version of the Oracle CRM Technology Foundation User Guide.
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Integrating Oracle Quoting With Oracle
Sales Contracts

This section contains information on integrating with Oracle Sales Contracts and
setting up contracts functionality.

Setting up Contracts Functionality
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8.1 Setting up Contracts Functionality

Oracle Quoting integrates with Oracle Sales Contracts to provide contract
functionality. The objective of Quoting/Contracts integration is to automate the
creation and delivery of quotes with default or negotiated terms.

Note: If a contract is canceled, you must run the Workflow
Background Process, with parameters Contract Approval and
Contract Alert, to enable the quote status to change from Contract
Pending to Contract Canceled.

In order to integrate Oracle Sales Contracts with Oracle Quoting, you must perform
the following:

Set up Oracle Quoting profile options
Set Contracts profile values

Set up an Independent Condition
Run background processes

Setup workflow notification mailer

8.1.1 Set up Oracle Quoting profile options

To enable use of Oracle Sales Contracts in Oracle Quoting, set the profile option
ASO: Enable Use Contracts. For more information on setting Oracle Quoting
profile options, refer to Chapter 4.2, "Setting System Profile Options".
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8.1.2 Set Contracts profile values

You must set specific Oracle Contracts Core profile options in order to use Oracle
Sales Contracts with Oracle Quoting.

For more information on Oracle Contracts Core profile options, refer to
Appendix A.3, "Oracle Contracts Core Profile Options" and the Oracle Contracts Core
Implementation Guide.

8.1.3 Set up an Independent Condition

To enable the quote status change to Contract Canceled, when the associated
contract is canceled, you must set up an independent condition in Contracts. See
Oracle Contracts Core Concepts and Procedures for more information.

Login

Login to Oracle Forms.

Responsibility

Contracts Manager

Prerequisites
None

Steps

1. Navigate to Contract Events > Define Independent Condition.
2. Enter a name for the condition.
3. Select Contract Status Change From LOV from the Action LOV.

4. In the Expression tab, select CONTRACT CURRENT STATUS CODE from the
Left Value LOV.

Select = from the Operator drop down menu.
Select CANCELED from the Right Value LOV.
In the Notifications tab, select Notify Sales Rep from the Outcomes LOV.

Select Parameters.

© ® N o o

Holding down the Control key, select the following three parameters:

P_CONTRACTID
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P_CONTRACT STATUS
P_API_VERSION

10. In the Parameters form, set the selected parameters as follows:
P_CONTRACT ID = CONTRACT ID
P_CONTRACT STATUS = CONTRACT CURRENT STATUS CODE
P_API_VERSION =1

11. Select OK.

12. Select the save icon.

8.1.4 Run background processes

For complete information on Workflow Background Engines, refer to the Oracle
Workflow Guide.

To run background processes:

Login

Login to Oracle Forms.

Responsibility

System Administrator

Prerequisites
None

Steps

1. Run the Workflow Background Engine as described in the Oracle Workflow
Guide.

2. Select Contract Approval and Contract Alert asthe Item Types.
3. Select Yes from the Process Deferred LOV.

4. Select Yes from the Process Timeout LOV.
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8.1.5 Setup workflow notification mailer

The Workflow Background Process must be running to enable:
= Contracts alerts to be sent
= Contract Approval process

For detailed instructions on setting up the Workflow Notification Mailer, refer to the
Oracle Workflow Guide.

To verify that the Workflow Background Process is running:

Login
Login to Oracle Applications.

Responsibility

System Administrator

Prerequisites
None

Steps

1. Verify if Workflow Background Process is running using the procedure
defined in the Oracle Workflow Guide.

Select Contract Alert as the Item Type.
Select Yes from the Process Deferred LOV.

Select Yes from the Process Timeout LOV.

a » 0 Dbd

The Request screen should return a list of subsequent requests that were
entered or completed for the Workflow Background Processes. If you are able to
see these entered or completed workflows, the Workflow Background Process is
running successfully.

8.1.5.1 If the Workflow Background Process is not Running Properly

If the Workflow Background Process is not running, you can run the process
manually or schedule the process to run automatically. See the Oracle Workflow
Guide for more information.
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Appendixes

This section of the Oracle Quoting Implementation Guide contains the following
chapters:

Appendix A, "Oracle Quoting Profile Options"

Appendix B, "Seeded Lookup Types"

Appendix C, "Oracle Quoting Security Scenarios"

Appendix D, "Seeded Attributes in Oracle Approvals Management (OAM)"
Appendix E, "Oracle Quoting Seeded Caches"
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Oracle Quoting Profile Options

This chapter describes required profile option settings. Topics include:
s Current Profile Options

= Oracle CRM Foundation Profile Options

= Oracle Contracts Core Profile Options

= Oracle Order Management Profile Options

= Oracle Pricing Profile Options

= Oracle Sales Online Profile Options

= Oracle TeleSales Profile Options

= Multi Organization (MO) Profile Options

= Oracle iStore Profile Options

= Oracle Self Service Web Applications Profile Options
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A.1 Current Profile Options

When implementing Oracle Quoting, you must set specific profile options. Profile
Options affect the appearance and performance of the application.

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

If you are using Quoting standalone, you should set profile options to either ASO
for the Forms UI, or QOT for the HTML UI at the Application level.

If you are integrating with Oracle TeleSales or Oracle Sales Online, you should set
profile options to either AST for the Forms Ul or AST for the HTML U, at the
Application level.

For multi-org applications, it is required that all org-striped profile options are set at
either the responsibility or user level. The following profiles are org-striped:

= ASO: Default Salesrep
= ASO: Default Order Type
s OKC: Contract Template for Standard Terms and Conditions

A.1.1 Oracle Quoting Profile Options for Approvals
The following profile options apply to Approvals functionality.
1. ASO: Enable Approvals
Determines availability of approvals functionality.
If set to Yes, approvals functionality is enabled.
If set to No, approvals functionality is disabled.
2. ASO: Allow Skip Approvers

Determines if the sales representative can skip approvers in the approval
process.

If set to Yes, the sales representative can skip approval levels when submitting a
quote for approval.

If set to No, all approvers must approve the quote.
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The following tables list default values and application levels for the Approvals
profile options.

Table A-1 Oracle Quoting Profile Options for Approvals

HTML or Forms Application

Profile Option Default Value ul Level

ASO: Enable Approvals Yes Both Site,
Application

ASO: Allow Skip Approvers No Both Site,
Application

A.1.2 Oracle Quoting Profile Options for Availability to Promise (ATP)
The following profile options apply to ATP functionality.

1.

ASO: ATP Use Sourcing Rule

Determines if sourcing rules are used to derive the relevant inventory
organizations for ATP.

Sourcing rules are defined in Materials Requirements Planning (MRP). Please
refer to the Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User
Guide Release 11i.

If set to Yes, ATP is calculated based on sourcing rules.

If set to No, the sourcing rules are not used and the ATP check is restricted to
the inventory organization specified in the profile ASO: Default Ship From
Org.

If null, then the default value NO is assumed.
ASO: ATP Default Customer and ASO: ATP Default Ship To Site

These profiles are set to a cust_account_id and cust_account_site_use_id (where
site_use = Ship_To) values respectively. They are used to determine the sourcing
rules, when no ship-to site exists for the quote. These profiles must be used in
conjunction with each other.

If ATP is performed before selecting a ship-to site, these default values are used.
If a ship-to site is selected, then the cust_account_site_use_id is used for the
ATP check only if the selected site is known to MRP. If MRP is not aware of the
selected ship-to site, then the cust_account_id and the cust_account_site_use_id
specified in these profiles is used.
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If MRP is aware of the customer and ship-to site, but there is no sourcing rule
for the combination of customer and ship-to site, then a Global Sourcing Rule or
a sourcing rule at the Item level must exist for ATP to work.

Note: Do not attempt to set these profiles if ASO: ATP Use Sourcing Rule is set
to No.

A value for these profiles is mandatory when ASO: ATP Use Sourcing Rule is
set to Yes.

If these profile values are null, no default values are assumed.
ASO: Default Ship From Org

Identifies the physical warehouse against which ATP and reservation are
performed.

Mandatory if ATP and Reservations are performed.
If null, no default value is assumed.

The following tables list default values and application levels for each of the
ATP profile options.

Table A-2 Oracle Quoting Profile Options for ATP

HTML or Application

Profile Option Default Value Forms Ul Level

ASO: ATP Default Customer N/A Both Site,
Application,
Responsibility

ASO: ATP Default Ship To N/A Both Site,

Site Application,
Responsibility

ASO: ATP Use Sourcing No Both Site,

Rule Application,
Responsibility

ASO: Default Ship From Org N/A Both Site,
Application,
Responsibility,
User
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A.1.3 Oracle Quoting Profile Options for Configurator

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following profile options apply to Oracle Configurator integration.

1.

ASO: Allow Quantity Updates for Top Level Model Item
Determines if users can update the quantity of a top level model.

If set to Yes, the user can change the quantity.

If set to No, the user cannot change the quantity and the quantity becomes read

only.
If null, defaults to Yes.
ASO: Allow Quantity Updates for Component Item

Determines if users can update the quantity for a component of a model or
delete the component.

If set to Yes, a user can update the quantity or delete the component.
If set to No, a user cannot update quantity or delete the component.
If null, defaults to Yes.

ASO: Configurator URL

Specifies the URL for the Configurator window.

Mandatory if Oracle Configurator is used for product configurations.
If null, no default value is assumed.

The following table lists default values and application levels for the
Configurator profile options.

Table A-3 Oracle Quoting Profile Options for Configurator

HTML or Application
Profile Option Default Value Forms Ul Level
ASO: Allow Quantity Updates Yes Both Site,
for Top Level Model Item Application
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Table A-3 Oracle Quoting Profile Options for Configurator

HTML or Application
Profile Option Default Value Forms Ul Level
ASO: Allow Quantity Updates Yes Both Site,
for Component Item Application
**ASO: Configurator URL N/A Forms Site,
Application,
Responsibility,
User

A.1.4 Oracle Quoting Profile Options for Contracts Integration

The following profile options apply to Oracle Contracts Core integration.
1. ASO: Enable Use Contracts

Enables Oracle Quoting integration with Contracts Core.

If set to Yes, Contracts integration is enabled.

If set to No, Contracts integration is disabled.

If null, a default of No is assumed.

2. ASO: Enable to Instantiate Contract When Default Terms and Conditions
Needed

Determines if a new contract is created at the time of order placement, if none
exists.

The following table lists default values and application levels for each of the
Contracts profile options.

Table A-4 Oracle Quoting Profile Options for Contracts

HTML or Forms Application

Profile Option Default Value Ul Level

ASO: Enable Use Contracts No Both Site, Application
ASO: Enable to Instantiate No Both Site, Application
Contract When Default Terms

and Conditions Needed

A.1.5 Oracle Quoting Profile Options for Credit Checks
The following profile options apply to credit checks:
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1. ASO: Enable Credit Check
Determines if the credit check functionality is enabled.
If set to Yes, users can initiate credit checks.
If set to No, users cannot initiate credit checks.
If null, defaults to No.
2. ASO: Credit Check Rule
Determines the credit check rule used for performing the internal credit check.
If not set, internal credit checks cannot be performed.
The following table lists the default values and application levels for the Credit
Check profile options.

Table 8-1 Oracle Quoting Profile Options for Credit Checks

HTML or Forms Application

Profile Option Default Value Ul Level

ASO: Enable Credit Check N/A Both Site, Application

ASO: Credit Check Rule N/A Both Site, Application,
Responsibility

A.1.6 Oracle Quoting Profile Options for Debugging
The following profile option applies to debugging.

1. ASO: Enable ASO Debug
Enable the ASO debug messages for a single session.

If set to Yes, then ASO debug messages are recorded in the folder specified in
Oracle Order Management’s profile.

If set to No, then no debug file is recorded
The following table lists the default value and application levels for the debugging

profile option.

Table A-5 Oracle Quoting Profile Options for Debugging

HTML or Application
Profile Option Default Value Forms Ul Level
ASO: Enable ASO Debug N/A Both User
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A.1.7 Oracle Quoting Profile Options for Expiration Date

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following profile options apply to the expiration date.

1.

ASO: Default Expiration GL Calendar

Selects the General Ledger calendar used to determine the quote expiration
date. Users can choose from all GL calendars set up in Accounts Receivable.

If set to None, no calendar will be used.
ASO: Default Expiration Period Type

Selects the General Ledger period type used to determine the quote expiration
date. Users can choose from all period types set up for the selected GL calendar
in Accounts Receivable.

If set to None, no period type will be used.
ASO: Quote Duration

Specifies the minimum length of time (in days) a quote remains valid. Oracle
Quoting uses this value to calculate the Expiration Date if the user does not
specify one.

Note: This profile is only considered if ASO: Default Expiration GL Calendar
and ASO: Default Expiration Period Type are not set.

If null, a duration of 30 days is assumed.

The following table lists default values and application levels for each of the
expiration date profile options.

Table A-6 Oracle Quoting Profile Options for Expiration Date

HTML or Application
Profile Option Default Value @ Forms Ul Level
ASO: Default Expiration GL None Both Site
Calendar
ASO: Default Expiration GL None Both Site
Period Type
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Table A-6 Oracle Quoting Profile Options for Expiration Date

HTML or Application
Profile Option Default Value = Forms Ul Level
**ASO: Quote Duration 30 Both Site,
Application,
Responsibility,
User

A.1.8 Oracle Quoting Profile Options for Inventory

The following profile option applies to inventory.

1.

ASO: Enable Manual Warehouse Selection

Allows the user to enable or disable the Warehouse field in the Quote Lines tab
and the Save Warehouse checkbox on the Availability form.

If set to Yes, the Warehouse field and Save Warehouse button are enabled.
If set to No, the Warehouse field and Save Warehouse button are disabled.

The following table lists the default value and application levels for the
inventory profile option.

Table A-7 Oracle Quoting Profile Options for Inventory

Default HTML or Application
Profile Option Value Forms Ul Level
ASO: Enable Manual No Forms Site,
Warehouse Selection Application
Responsibility,
User

A.1.9 Oracle Quoting Profile Options for Manual Discounts

The following profile option applies to manual discounts.

1.

ASO: Discounting Privilege
Allows the user to make manual adjustments to the price returned from the
pricing engine.

If set to Full, the user can manually adjust a price by changing the Unit Selling
Price in the Oracle Quoting UL The user can add non-automatic adjustments
and can also override the value if the override flag is checked in Oracle
Advanced Pricing.
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If set to Partial, the user can only select non-automatic adjustments. This value
applies only to the Forms UL

If set to None, the user cannot manually adjust a price by changing the Unit
Selling Price in the Oracle Quoting Ul and cannot apply any non-automatic
adjustments.

If null, a default of None is assumed.
ASO: Require Minus Sign for Manual Discount

Determines the format for entering manual discounts and surcharges on the
Lines page (HTML UlI).

If set to Yes, a positive number is applied as a surcharge, increasing the Unit
Selling Price. A negative number is applied as a discount, decreasing the Unit
Selling Price.

If set to No, a positive number is applied as a discount, decreasing the Unit
Selling Price and a negative number is applied as a surcharge, increasing the
Unit Selling Price.

If null, a default value of No is assumed.

The following table lists the default value and application levels for the manual
discounts profile option.

Table A-8 Oracle Quoting Profile Options for Manual Discounts

Default HTML or
Profile Options Value Forms Ul Application Level
ASO: Discounting Privilege None Both Site, Application,
Responsibility,
User
ASO: Require Minus Sign For ~ No HTML Site

Manual Discount

A.1.10 Oracle Quoting Profile Options for Orders

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following profile options apply to orders.
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ASO: Default Order Type

Determines how the order will be processed in Oracle Order Management.
Order types are set up in Oracle Order Management.

If null, no default value is assumed.

Note: Set up of this profile is mandatory for tax calculations and for using line
types functionality.

ASO: Default Order State

Determines the order state, booked or entered, when the order is created from a
quote.

If null, the default value of booked is assumed.

ASO: Default Return Reason

Default reason for item return, if no reason is specified by the customer.
Mandatory for all return lines.

If null, then no default value is assumed.

ASO: Default E-Business Order Screen

Specifies the default Sales for Communications order form launched when the
user selects the Details button while viewing Orders in the Quote/Order tab of
the Oracle TeleSales E-Business form.

ASO: Default E-Business Quote Screen

Specifies the default Sales for Communications quote form launched when the
user selects the Details button while viewing Quotes in the Quote/Order tab of
the Oracle TeleSales E-Business form.

ASO: OM Defaulting

Determines whether Oracle Order Management should default values,
following Oracle Order Management rules, for the following order attributes,
when creating an order from a quote:

= payment_term_id
s fob_code
= freight_terms_code

= shipment_priority_code
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If set to No and a quote is created with null values for the above fields, the
corresponding order shows these fields as null.

If set to Yes and a quote is created with null values for the above fields, the
corresponding order will have values defaulted into the fields, using the Oracle
Order Management defaulting rules.

7. ASO: Order Feedback Queue Retention Time

Determines the length of time, in seconds, that messages are retained in the
order feedback queue.

Caution: It is very important that you enter a value for this profile.

Set the profile value to null, meaning that the message never expires, or to a
large number. The setting depends on your business needs and the applications
that are interested in the queued information.

If null, the message will be retained in the queue indefinitely.

For more information, see the Order Feedback FAQ in the Oracle Quoting
Implementation Guide.

8. ASO: Quote Conversion Type

Specifies the currency conversion type used to derive the daily conversion rate
from Oracle General Ledger if the OM: Set of Books profile currency for the
order is different from the currency used to create the associated quote.

If null, no default value is assumed.
9. ASO: Reservation Level

Determines the level at which item reservations are performed. Items can be
reserved manually, or automatically when the order is submitted.

Mandatory if reservations are performed.

Note: Quoting does not support the value Automatic Reservation
- Add to Cart.

If set to AUTO_ORDER, a reservation is made when an order is placed.

If set to MANUAL, reservations must be entered manually in Oracle Order
Management.

If null, a default value of Manual is assumed.
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The following table lists default values and application levels for each of the

orders profile options.

Table A-9 Oracle Quoting Profile Options for Orders

Profile Option

Default Value

HTML or
Forms Ul

Application
Level

ASQ: Default E-Business Order
Screen

ASQ: Default E-Business Quote
Screen

*ASO: Default Order Type

ASQ: Default Order State

**ASQO: Default Return Reason

ASQO: OM Defaulting
ASOQO: Order Feedback Queue
Retention Time

*ASO: Quote Conversion Type

ASO: Reservation Level

Order
Organizer

Quoting

N/A

Booked

N/A

N/A

N/A

Manual

Forms

Forms

Both

Both

Both

Both

Both

Both

Both

Site,
Responsibility

Site,
Responsibility

Site,
Application,
Responsibility,
User

Site,
Application,
Responsibility,
User

Site,
Application,
Responsibility,
User

Site,
Application

Site,
Application

Site,
Application,
Responsibility,
User

Site,
Application,
Responsibility,
User
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A.1.11 Oracle Quoting Profile Options for Oracle Sales Online (OSO) Integration

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following profile option applies to OSO integration.
1. ASO: Enable OSO Integration
Indicates whether OSO is integrated with Oracle Quoting.
If set to Yes, customer, contact, and address are displayed as hyperlinks to OSO.
If set to No, integration with OSQO is not enabled.
Note: This profile is mandatory if the HTML Ul is accessed through OSO.
The following table lists default values and application levels for the OSO

integration profile option.

Table A-10 Oracle Quoting Profile Options for OSO Integration

HTML or Application
Profile Option Default Value Forms Ul Level
**ASO: Enable OSO Integration No HTML Site,
Application

A.1.12 Oracle Quoting Profile Options for Payments

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following profile options apply to payments.
1. ASO: Credit Card Authorization

Determines whether the application does a credit card authorization when
creating an order from a quote.

If set to Yes, the credit card is authorized when creating an order from a quote.
If set to No, no credit card authorization is performed.

If null, a default value of No is assumed.
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2.

ASO: Receipt Method

Determines the receipt method for credit card authorization.
Mandatory when ASO: Credit Card Authorization is set to Yes.
If null, no default value is assumed.

The following table lists default values and application levels for each of the
payments profile options.

Table A-11 Profile Options for Payments

Default HTML or Application
Profile Option Value Forms Ul Level
ASO: Credit Card No HTML Site, Application,
Authorization Responsibility,
User
**ASO: Receipt Method N/A HTML Site, Application,
Responsibility,
User

A.1.13 Oracle Quoting Profile Options for Pricing and Tax
The following profile options apply to the pricing functionality.

1.

ASOQO: Calculate Price

Determines when the products and services in the quote are priced. Possible
values: automatic and manual.

If set to Automatic, the quote is priced automatically each time a price-affecting
change is made.

If set to Manual, users can price the quote whenever they choose.

If null, defaults to Automatic.

Note: Setting ASO: Calculate Price to Automatic and ASO:
Calculate Tax to Manual is not recommended and not supported.
This is not a valid setup, and the tax calculation may be wrong.

ASOQO: Calculate Tax

Oracle Quoting Profile Options A-15



Current Profile Options

Determines when tax is calculated for the quote. Possible values: automatic and
manual.

If set to Automatic, the tax is calculated automatically each time a
price-affecting change is made.

If set to Manual, users can calculate tax for the quote whenever they choose.
If null, defaults to Automatic.
3. ASO: Enable Batch Processing

Determines how the quote is priced. If you choose to price the quote
interactively, you must wait while the quote is being priced. If the quote is
priced via a batch process, you will be notified when the pricing call is
complete.

The following table lists default values and application levels for each of the
pricing profile options.

Table A-12 Profile Options for Pricing

Default HTML or Application

Profile Option Value Forms Ul Level

ASO: Calculate Price Automatic  Both Site, Application,
Responsibility,
User

ASO: Calculate Tax Automatic  Both Site, Application,
Responsibility,
User

ASO: Enable Batch Processing  No Both Site

A.1.14 Oracle Quoting Profile Options for Print Quote

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following profile options apply to the print quote functionality.
1. ASO: Company Report Logo

Indicates the location of the gif file used for the company logo.
2. ASO: Print Quote Reports Directory
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Specifies the directory location for the report source files.
ASO: Print Quote Show Attachments

Determines if attachments associated with the quote may be printed during the
print quote process.

If set to Yes, attachments can be printed.
If set to No, attachments cannot be printed.
If null, a default value of Yes is assumed.

The following table lists default values and application levels for each of the
print quote profile options.

Table A-13 Oracle Quoting Profile Options for Print Quote

HTML or Application
Profile Option Default Value Forms Ul Level
ASO: Company Report Logo N/A Both Site,
Application,
Responsibility
*ASO: Print Quote Reports N/A Both Site
Directory
ASOQ: Print Quote Show Yes Both Site
Attachments

A.1.15 Oracle Quoting Profile Options for Quote Templates

The following profile option applies to quote templates.

1.

ASO: Manage Quote Template
Determines if a user can create, modify, or delete quote templates.
If set to Yes, the user can create, modify, and delete templates.

If set to No, the user has read only access to templates but can create quotes
from templates.

If null, a value of No is assumed.

The following table lists the default value and application level for the quote
templates profile option.
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Table A-14 Oracle Quoting Profile Options for Quote Templates

HTML or Forms Application

Profile Option Default Value Ul Level

ASO: Manage Quote No HTML Site,

Template Application,
Responsibility,
User

A.1.16 Oracle Quoting Profile Options for Quotes

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following profile options apply to quotes.
1.  ASO: Auto Account Creation

Determines if an account should be automatically created when the quote is
updated.

If Always, and sold-to/ship-to/bill-to party without an active account is on a
quote, an account is automatically created when user saves the quote. If a new
party is created, an account is created simultaneously.

If As Required, and sold-to/ship-to/bill-to party on quote does not have a
single active account, an account is created for each of these parties when the
quote is web published, a new contract is initiated, or the quote is submitted to
Oracle Order Management.

If Place Order, and sold-to/ship-to/bill-to party on quote does not have a
single active account, an account is created for each of these parties when the
quote is submitted to Oracle Order Management.

If null, defaults to As Required.
2. ASO: Automatic Numbering
Determines if the system automatically generates a quote number.
If set to Yes, a new quote number is generated by the system.
If set to No, the user must specify the quote number.

If null, a default value of Yes is assumed.
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10.

ASO: Category Set

Determines the category set for the Category drop down on the Search and
Select: Product page (HTML UI).

Determines the category set used, if the user chooses to Print Subtotals by
Category when printing a quote.

ASO: Default Currency Code
If null, the default value USD is assumed.
ASO: Default Customer Type

Determines the Customer Type (person or organization) field for the sold-to,
bill-to, and ship-to customers.

If set to Person, the customer type defaults to person.
If set to Organization, the customer type defaults to organization.
ASO: Default Ordered Qty in OC Ul

Determines the default quantity that appears in the QTY field of the Oracle
Quoting window.

If null, a default quantity of 1 is assumed.
ASO: Default Quote Status

Determines the default status of a new quote.
ASO: Default Sales Channel

Determines the default sales channel for quotes if the Primary Sales Agent and
Sales Group defaulted from ASO: Default Salesrep and ASO: Default Sales
Group.

ASO: Enable Line Level Billing

Determines if you can designate billing information at the line level.
If set to Yes, you can designate billing information by line.

If set to No, you cannot designate billing information by line.

If null, a default value of No is assumed.

ASO: GSA Pricing

Allows users to check the GSA violation returned by the Pricing engine.
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If set to Warning, the application checks for a GSA violation and returns a
warning message to the user. The transaction continues.

If set to Error, the application checks for a GSA violation and returns an error
message to the user. The transaction is stopped.

If null, GSA violation checks are ignored.
11. ASO: Max Number of Results

Determines the maximum number of search results displayed in the quote and
customer searches, and all customer and account LOVs in the Forms Ul

If null, defaults to 100.
12. ASO: Require Service Reference on Add to Quote

Determines when the user must complete the service reference form for a
service item.

If set to Yes, the user must complete the service reference before adding a
service item to the quote.

If set to No, the user may complete the service reference when adding the
service to the cart or before placing the order.

If null, a value of Yes is assumed.
13. ASO: Show Line Level Tax Details
Determines if tax details are displayed at the line level.
If set to Yes, tax details will display at the line level if the item is taxable.
If set to No, tax details will not be displayed at the line level.
If null, a value of No is assumed.
The following table lists default values and application levels for each of the

quote profile options.

Table A-15 Quoting Profile Options for Quotes

Default HTML or  Application
Profile Option Value Forms Ul Level
ASO: Auto Account Creation ~ As Required Both Site, Application
*ASO: Automatic Numbering  Yes Both Site, Application,
Responsibility
ASO: Category Set NA Both Application
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Table A-15 Quoting Profile Options for Quotes

Default HTML or  Application

Profile Option Value Forms Ul Level

ASO: Default Currency Code ~ USD Forms Site, Application,
Responsibility,
User

ASO: Default Customer Type ~ Organization HTML Site, Application

ASO: Default Ordered 1 Both Site, Application,

Quantity in OC Ul Responsibility,
User

*ASQ: Default Quote Status Draft Both Site, Application

ASO: Default Sales Channel N/A Both Site, Application,
Responsibility,
User

ASO: Enable Line Level Billing No Both Site, Application,
Responsibility

ASO: GSA Pricing N/A Both Site, Application

ASO: Max Number of Results 100 Forms Site, Application

ASO: Require Service Yes Forms Site

Reference on Add to Quote

ASQ: Show Line Level Tax No HTML Site, Application,

Details Responsibility
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A.1.17 Quoting Profile Options for Sales Supplement (HTML)

The following profile options apply to sales supplement functionality.

1. ASO: Default Sales Supplement Template
Sets the default sales supplement template.

2. ASO: Enable Sales Supplement
Determines if the sales supplement functionality is accessible to users.
If set to Yes, sales supplement is enabled.
If set to No, sales supplement information is not accessible to users.
If null, a value of No is assumed.
The following table lists default values and application levels for each of the

sales supplement profile options.

Table A-16 Quoting Profile Options for Sales Supplement
HTML or Application

Profile Option Default Value Forms Ul Level

ASO: Enable Sales No HTML Site, Application

Supplement

ASOQO: Default Sales N/A HTML Site, Application,

Supplement Template Responsibility,
User
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A.1.18 Oracle Quoting Profile Options for Searching

The following profile option applies to Search functionality.
1. ASO: Enable Intermedia Search
Determines if the product search (against the Product Catalog) uses Intermedia.
If set to Yes, the product search uses Intermedia.
If set to No, the product search uses the existing search tables/views.
If null, a default value of No is assumed.
The following table lists default value and application levels for the search
profile option.
Table A-17 Quoting Profile Options for Sales Supplement
HTML or Application

Profile Option Default Value Forms Ul Level
ASQ: Enable Intermedia No Both Site, Application
Search

A.1.19 Quoting Profile Options for Security

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following profile options apply to Security functionality.
1. ASO: Create New Customer

Allows the user to create new customer information. In the Forms UI, enables
or disables the Create Customer form. In HTML, allows the user to create new
sold-to customers.
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Note: In the Forms Ul new customers are created using the AR
form. This form automatically creates a new account for each new
customer. If you do not want user to create new accounts when
creating new prospect customers, you must disable the Create
Customer form by setting the profile option ASO: Create New
Customer to No. Users can create new customers using the Create
Customer form in the Oracle TeleSales E-Business Center.

If set to Yes, the user can create new customers.
If set to No, the user cannot create new customers.
If null, a default value of Yes is assumed.
2. ASO: Create New Shipping/Billing Customer
Determines if HTML users can create new shipping or billing customers.
If Yes, users can create new shipping and billing customers.
If No, users cannot create new shipping and billing customers.
If null, defaults to Yes.
3. ASO: Default Sales Group

Populates the primary sales representative group when the primary sales
representative defaults from ASO: Default Salesrep. This group must be a sales
group with the usage "Sales and TeleSales". Ensure that the selection is valid for
the sales representative selected in ASO: Default Salesrep.

4. ASO: Default Salesrep

Provides a default sales representative on the quote, if the logged-in user is not
a valid sales representative.

5. ASO: Enable Security Check

Determines whether Quote Access Security is enabled. Quote Access Security
determines which quotes users can access and at what levels.

If set to Yes, users can access only those quotes belonging to a sales team they or
one of their subordinates belong to. Limits user’s access level as well.

If set to No, users have update access to all quotes.

If null, a value of No is assumed.
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Note: If this profile is set to No, you should not set other Security profiles, as
they are do not work when security is turned off.

ASO: Enable Submit Button

Determines which users can submit orders.

If set to Yes, users can submit an order.

If set to No, the submit button is disabled and users cannot submit orders.
If null, a value of Yes is assumed.

ASO: Enforce Account Relationships

Determines if user can select only ship-to/bill-to customers with existing
relationships to the sold-to customer.

If Yes, the user can only select ship-to or bill-to customers with existing
relationships to the sold-to customer. In HTML UlI, allows user to conduct a
blank search for ship-to or bill-to customers.

If No, the user can select any ship-to or bill-to customer regardless if there is an
existing relationship with the sold-to customer.

If null, defaults to No.
ASO: Manager Role Access
Determines what level of access a manager has to quotes.

If set to Update, the manager can update all quotes associated with the quote
sales teams their subordinates belong to.

If set to Inherit, the manager has the same access as a subordinate on the quote
sales team. If the manager has multiple subordinates with different access levels
on a single sales team, the manager has the higher access level.

If null, a default value of Inherit is assumed.
ASO: New Quote Security
Controls the user’s ability to create new quotes.

If set to Yes, the user cannot create new standalone quotes unless the quote is
created from an opportunity.

If set to No, the user can create new standalone quotes. This includes copying
existing quotes to new quotes and creating quotes from opportunities.
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If set to Sales Team, the user can only create new quotes for customers if they
belong to the customer’s sales account team.

Note: Create customer sales teams using the Territory Manager
module of Foundation, Oracle Sales Online or Oracle TeleSales.

10. ASO: OM Access

Determines the mode of access to Oracle Order Management forms via the
Customer History form. Access can be Full or Read Only. These values are
based on the lookup type ASO_OM_ACCESS_PRIVILEGE.

If set to Full, the user can update an order in the Oracle Order Management
form.

If set to Read Only, the user can only view an order in the Oracle Order
Management form.

If null, a value of Full is assumed.

11. ASO: Price List Override
Allows the user to select a different price list for a quote.
If set to Yes, the user is able to override the default price list selection.
If set to No, the user cannot override the default price list.
If null, a default value of Yes is assumed.

12. ASO: Require Group
Determines if a group selection is required for the Primary Sales Agent.
If set to Yes, the user cannot save the quote until a group selection is made.
If set to No, the user can save the quote without a group selection.
If null, a default value of No is assumed.

Note: If this profile option is set to Yes, setting up at least one group for each
sales representative is mandatory.

13. ASO: Security Enable From API

Determines if security is enabled through the security APIs. This profile is
mandatory if Security is enabled.
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14.

15.

16.

17.

If set to Yes, the security APIs are enabled and Security functionality is
accessible.

If set to No, the security APIs are not available and Security functionality is not
accessible.

If null, a default value of No is assumed.

Note: This profile completely disables security. It is intended to improve
application performance and should be set to No only if there are no users with
security enabled through ASO: Enable Security Check. This profile must be set
to Yes if you have any users with security enabled through ASO: Enable
Security Check.

ASOQ: Status Override

Determines whether a user can update the quote while it is in a read-only
status.

If set to Yes, user is able to override read-only data for quotes in read-only
status.

If set to No, user cannot update data for quotes in a read-only status.
If null, a default value of No is assumed.

ASO: Update Customer

Allows the user to update existing customer information.

If set to Yes, user can update existing customer information.

If set to No, user cannot update existing customer information.

If null, a default value of Yes is assumed.

ASO: Update Sales Team

Allows user to manually update Sales Team information, including manual
assignment of the primary sales agent.

If set to Yes, user is able to update primary sales representative and sales team
information.

If set to No, the user cannot update primary sales representative and sales team
information.

If null, a default value of Yes is assumed.

ASO: Validate Salesrep
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This profile is used to determine whether a sales representative must be
specified on the quote prior to creating an order.

If set to Yes, a sales representative must be specified on the quote prior to
creating an order.

If set to No, a sales representative will be defaulted from ASO: Default
Salesrep.

If null, a default value of Yes is assumed.

18. ASO: View Customers Without Accounts
Determines if the user can view only customers with at least one active account.
If Yes, a user can view all sold-to/ship-to/bill-to customers.

If No, user can view only sold-to/ship-to/bill-to customers with at least one
active account.

If null, defaults to Yes.

The following table lists default values and application levels for each of the
security profile options.

Table A-18 Quoting Profile Options for Security

HTML or Application

Profile Option Default Value Forms Ul Level

ASO: Auto Account Creation As Required Both Site, Application

ASO: Create New Customer Yes Both Site, Application,
Responsibility,
User

ASQ: Create New Yes HTML Site, application,

Shipping/Billing Customer Responsibility,
User

ASO: Default Sales Group N/A Both Site, Application,
Responsibility,
User

ASO: Default Salesrep N/A Both Site, Application,
Responsibility,
User

ASO: Enable Security Check No Both Site, Application,
Responsibility,
User

A-28 Oracle Quoting Implementation Guide



Current Profile Options

Table A-18 Quoting Profile Options for Security

HTML or Application

Profile Option Default Value Forms Ul Level

ASQ: Enable Submit Button Yes Both Site, Application,
Responsibility,
User

ASO: Enforce Account No Both Site, Application,

Relationships Responsibility,
User

ASO: Manager Role Access Inherit Both Site, Application,
Responsibility,
User

ASO: New Quote Security No Both Site, Application,
Responsibility,
User

ASQO: OM Access Full Forms Responsibility,
User

ASO: Price List Override Yes Both Site, Application,
Responsibility,
User

ASO: Require Group No Both Site

**ASO: Security Enable From No Both Site

API

ASQO: Status Override No Both Site, Application,
Responsibility,
User

ASO: Update Customer Yes HTML Site, Application,
Responsibility,
User

ASO: Update Sales Team Yes Both Site, Application,
Responsibility,
User

ASO: Validate Salesrep Yes Both Site, Application,
Responsibility,
User

ASO: View Customers Without Yes Both Site, Application,

Accounts Responsibility,
User
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A.1.20 Quoting Profile Options for Trade-ins

The following profile option applies to trade-ins.
1. ASO: Enable Line Type
Allows the user to enter line types and categories.
If set to Yes, line types and categories can be entered in the Oracle Quoting UL

If set to No, line types and categories cannot be entered and the default line
category "ORDER" is in effect in the Oracle Quoting UL

If null, a default value of No is assumed.

The following table lists the default value and application levels for the payments
profile option.

Table A-19 Quoting Profile Options for Trade-ins

HTML or Application
Profile Option Default Value Forms Ul Level
ASO: Enable Line Type No Both Site,
Application,
Responsibility,
User
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A.1.21 Oracle Quoting Profile Options for Web Publishing

The following profile option applies to the web publishing functionality.

1. ASO: Enable Web Publishing
Enables web publishing functionality to Oracle iStore.
If set to Yes, the user can publish quotes.
If set to No, the user cannot publish quotes.
If null, a default value of No is assumed.

The following table lists default value and application levels for the web publishing

profile option.

Table A-20 Oracle Quoting Profile Options for Publishing

Default HTML or Application

Profile Option Value Forms Ul Level
ASO: Enable Web Publishing No Both Site,
Application

A.2 Oracle CRM Foundation Profile Options

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following table lists the CRM Foundation profile options that must be set
during Oracle Quoting implementation.

Table A-21 JTT Profile Options for Quoting

HTML
or
Default Forms Application
Profile Option Description Value Ul Level
*JTF_PROFILE_DEFAULT_ Determines the default  N/A HTML Site,
APPLICATION application in the HTML Application,
UL Responsibility,
User
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Table A-21 JTT Profile Options for Quoting

HTML
or
Default Forms Application
Profile Option Description Value Ul Level
*JTF_PROFILE_DEFAULT_ Determines the default  N/A HTML Site,
CURRENCY currency in the HTML Application,
UL Responsibility,
User
JTF_PROFILE_DEFAULT _ Determines the number N/A HTML Site,
NUM_ROWS of rows in the HTML UL Application,
Responsibility,
User
JTF_PROFILE_DEFAULT _ Determines the default  N/A HTML Site,
RESPONSIBILITY responsibility in the Application,
HTML UL Responsibility,
User
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A.3 Oracle Contracts Core Profile Options

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following table lists the Oracle Contracts Core profile options that must be set
during Oracle Quoting implementation.

Table A-22 Contracts Core Profile Options for Quoting

HTML
or
Default Forms Application
Profile Option Description Value Ul Level
**OKC: Contract Template for Determines the contract N/A Both  Site,
Standard Terms and template for standard Application,
Conditions terms and conditions. Responsibility
Mandatory if ASO:
Enable Use Contracts is
set to Yes.
OKC: Default Contract Determines which N/A Both  Site,
Administrator for Contract Administrator Application,
Notifications receives notification Responsibility

when a sales
representative requests
contract creation from a
quote.
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A.4 Oracle Order Management Profile Options

Specific Oracle Order Management profile options must be set during Oracle
Quoting implementation. For more information on Oracle Pricing profile options,
refer to the Oracle Order Management Suite Implementation Guide.

The following table lists the description and default value for the Order
Management profile option that must be set during implementation.

Table A-23 Oracle Order Management Profile Options

HTML
or
Default Forms Application
Profile Option Description Value Ul Level
OM: Use Configurator Indicates which Oracle No Both  Site

application software will
be launched to enter
configuration
information.

Should be set to Yes if a
quote with model items
will become an order.
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A.5 Oracle Pricing Profile Options

Specific Oracle Pricing profile options must be set during Oracle Quoting
implementation. For more information on Oracle Pricing profile options, refer to the
Oracle Pricing User's Guide.

The following table lists the description and default value for the Pricing profile
option that must be set during implementation.

Table A-24 Pricing Profile Options for Quoting

HTML
or
Default Forms Application
Profile Option Description Value Ul Level
QP: Verify GSA Violations Indicates whether the No Both  Site

pricing calculation
engine should test for
GSA violations.

If set to Yes, Pricing tests
for GSA violations.

If set to No, Pricing does
not check for GSA
violations.

Mandatory if ASO: GSA
Pricing is set to Error or
Warning.
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A.6 Oracle Sales Online Profile Options

If Quoting - HTML is integrated with Oracle Sales Online, specific Oracle Sales
Online profile options must be set up during Oracle Quoting implementation. For
more information on Oracle Sales Online profile options, refer to the Oracle Sales
Online Implementation Guide.

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following table lists the description and default value for the OSO profile
option that must be set up during implementation.

Table A-25 OSO Profile Options for Quoting

Default Application

Profile Option Description Value Level
**OS0: Default Sales Group A value for this profile option =~ N/A Site,
and Role is mandatory if Quoting is Application,
accessed through OSO. Responsibility,
User
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A.7 Oracle TeleSales Profile Options

If Quoting - Forms is integrated with Oracle TeleSales, specific Oracle TeleSales
profile options must be set during Oracle Quoting implementation. For more
information on Oracle TeleSales profile options, refer to the Oracle TeleSales
Implementation Guide.

Note: Profile options with an asterisk are mandatory. Profile
options with a double asterisk are conditionally mandatory.

The following table lists the description and default value for the TeleSales profile
option must be set during implementation.

Table A-26 TeleSales Profile Options for Quoting

Default Application

Profile Option Description Value Level
**OTS: Default User Roleand A value for this profile option N/A User
Sales Group is mandatory if Quoting is

accessed through Oracle

TeleSales.

A.8 Multi Organization (MO) Profile Options

Verity or set the MO: Operating Unit profile option to the appropriate operating
unit at the responsibility level. Mandatory profile option.
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A.9 Oracle iStore Profile Options

The following Oracle iStore profile option must be set if you want to use web
publishing. For more information on Oracle iStore profile options, refer to the Oracle
iStore Implementation Guide.

= Set IBE: iStore Non Secure URL to iStore URL at the Application level

Note: If you are using the HTML Ul and are integrated with
Oracle Sales Online, you must set IBE: iStore Non Secure URL at
the Application level for the application Oracle Field Sales. If you
are not integrated with OSO, the profile should be set at the
Application level for Oracle Quoting.
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A.10 Oracle Self Service Web Applications Profile Options

The following profile option must be set if you want to print in Oracle Quoting. For
more information, refer to the Oracle Business Intelligence System Implementation
Guide.

Set ICX: Report Server to the key map value located in the file CGIecmd.dat. See
Section 4.12, "Setting Up the Print Quote Functionality" for more information.
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Seeded Lookup Types

If lookups have System level access you can modify the meaning and description.
If lookups have User level access, you can:

s Change the meaning and description

= Change the tag (sort sequence)

= Disable a lookup up

Note: Addition of new lookup codes is not supported under any
circumstances, unless otherwise specified. If a lookup type is
preceded by an asterisk, you can add new lookup codes to the
lookup type.

Table B-1 lists descriptions and access levels for seeded Oracle Quoting Lookup
Types (QuickCodes).

Table B-1 Oracle Quoting Lookup Types

Access
Lookup Type Description Level
ASO_ACCOUNT_CREATION Lookup for profile option ASO: Auto ~ System

Account Creation.

ASO_APPROVAL_INSTANCE_ Status of an approval instance System
STATUS
ASO_APPROVER_STATUS Status of an approver response System
ASO_BATCH_PROCESSING_ Lists the batch processing phases. System
PHASES
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Table B-1 Oracle Quoting Lookup Types

Access
Lookup Type Description Level
ASO_CONFIGURATION_STATUS Lists the product configuration System
statuses.
ASO_CUSTOMER_TYPE Defines customer type for sold-to, System
bill-to, and ship-to customers
ASO_DEFAULT_ORDER_STATE Default order state when quote passes System
to Oracle Order Management. Seeded
values are Entered and Booked. Each
triggers different Oracle Order
Management validation.
ASO_DISCOUNTING_PRIVILEGE  Discounting privilege for manual System
discounting
ASO_ER_REFRESH_MODE Quoting mode in which fact tables are  System
refreshed
ASO_FORMS_ACTION Lists the values for the Actions LOV in User
the Quoting form.
ASO_GSA_PRICING Determines level of error message for ~ System
GSA violation
ASO_IB_ACTION_TYPES Types of actions that appear on the User
Search and Select: Installed Base
Product page of the HTML UL
ASO_IB_RELATIONSHIP_TYPES  Types of relationships that appear on ~ User
the Installed Base Relationships page
of the HTML UL
ASO_ITEM_TYPE Item types for items which are added  System
to the cart
ASO_LINE_ACTION Type of line actions that appear on the  User
Lines page of the HTML UL
ASO_LINE_ITEM_ACTIONS Type of actions available in the Actions User
menu on the Lines page. HTML Ul
ASO_OM_ACCESS_PRIVILEGE Determines mode of access to the System
Oracle Order Management form via
the Customer History form
ASO_ORDER_FEEDBACK_CRM_  CRM applications registered for order ~User

APPS
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Table B-1 Oracle Quoting Lookup Types

Access
Lookup Type Description Level
ASO_PAYMENT_TYPE Payment types available to users System
*ASO_PQUOTE_TEMPLATES Templates that are not organization User
specific are defined in this lookup
*ASO_PQUOTE_OUTPUT_FMT Output format for print quote reports ~ User
ASO_PRICE_TAX_COMPUTE_ Lists the pricing and tax computation ~ System
OPTIONS options.
ASO_PRICE_TAX_STATUS_ Lists the pricing and tax status System
INDICATOR indicators.
ASO_PRODUCT_SOURCE Types of product sources available on ~ User
the Search and Select Product page
(THML UI).
ASO_QUOTE_ACTION Types of actions available on the User
Overview page of HTML UL
ASO_QUOTE_SECURITY Provides values for the profile ASO: System
New Quote Security. The lookup
codes here should not be changed.
ASO_QUOTE_SOURCE Quote source System
ASO_RESERVATION_TYPE Determines values for level at which System
Reservation needs to be done
ASO_SAVED_SEARCH Lists the saved searches in the HTML  System
UL
ASO_SECURITY_MGR_ROLE_ Values for security profile ASO: System
ACCESS Manager Role Access
ASO_SERVICE_TYPE Service reference type code. A service  System
must always be linked to an inventory
item or an item in the customer install
base. This list of values specifies where
the item is. Seeded values include:
Quote, Order, and Customer Product.
ASO_SERVICE_VALIDATION_ Validation used for ordering services System
TYPE on a quote.
ASO_SUP_COMPONENT_TYPE Sales supplement data component System

type

Seeded Lookup Types
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Table B-1 Oracle Quoting Lookup Types

Access
Lookup Type Description Level
ASO_SUP_PRESENTATION_ Sales supplement data presentation System
STYLE style
ASO_SUP_RESPONSE_TYPE Sales supplement response type System
ASO_SUP_SECTION_ Sales supplement section component System
COMPONENT_TYPE type
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The following table lists the obsolete Oracle Quoting Lookup Types.

Table B-2 Obsolete Oracle Quoting Lookup Types

Lookup Type Description
ASO_CONTACT_PROFILE_ Profile type of a customer contact
TYPE

ASO_ORDER_LINE_STATUESES Status of an order line
ASO_ORDER_STATUSES Order status
ASO_PARTY_RELATIONSHIP_  Type of party relationship

TYPE

ASO_NON_DEFAULT_ Approval level for non-default contract options
CONTRACT

ASO_QUOTE_RELATED_ Seeded lookup data required for data
OBJECTS migration in Sales
ASO_RETURN_FOR Reasons for returns

ASO_UNIVERSAL_SEARCH Types of universal search
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C

Oracle Quoting Security Scenarios

This section contains scenarios demonstrating uses for Oracle Quoting Security.
= Scenario 1 — Organization Split Into Regions and Districts
»  Scenario 2 — New Quote Security

m  Scenario 3 — Call Center Environment
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Scenario 1 — Organization Split Into Regions and Districts

C.1 Scenario 1 — Organization Split Into Regions and Districts

A national sales organization headed by Ruth Stamos is split into East and West
regions with districts in the Eastern region.

The following diagram shows the hierarchy of the employees at the organization.

Mational Sales Manager
Ruth Stamos

Regional Sales Manager - Regional Sales Manager -
est East
Audry Clark Richard Lee

I : Scenario 2

District Sales Manager - District Sales Manager -
Mortheast District Southeast District
Ken Lewy Allison Hashimoto

Manager - New Products
Karen Gibsan

Jessie Chan Alma Santiago
Senior Sales Sales Representative
Representative

Rense Watsan Jemywiashington George Clak William Frederick
Salesa Representative Senior Sales H Sales Sales
Reepresentative

The following table lists the roles for the organization and the flags that should be
selected for the role during set up.

Table C-1 Roles

Role Flag

National Sales Manager Manager
Regional Sales Manager Manager
District Sales Manager Manager
Sales Representative Member
Senior Sales Representative Member

Setup of this scenario requires the following steps:

1. Create a resource for each person.
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Scenario 1 — Organization Split Into Regions and Districts

The following table lists the resources set up for the organization.

Resource

Ruth Stamos

Audrey Clark

Richard Lee

Ken Levy

Allison Hashimoto

Karen Gibson

Jessie Chan

Alma Santiago

Renee Watson

Jerry Washington

George Clark

William Frederick

2. Create 5 roles.

The following table shows the roles set up for the company and the flags that
must be enabled for each role during setup.

Table C-2 Roles

Role Name

Flag Selected

National Sales Manager

Manager

Regional Sales Manager

Manager

District Sales Manager

Manager

Sales Representative

Member

Senior Sales Representative

Member

3. Assign roles to resources.

The following table shows the roles assigned to each resource within the

organization.
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Scenario 1 — Organization Split Into Regions and Districts

Table C-3 Assign Roles to Resources

Resource Role

Ruth Stamos National Sales Manager
Audrey Clark Regional Sales Manager
Richard Lee Regional Sales Manager
Ken Levy District Sales Manager
Allison Hashimoto District Sales Manager
Karen Gibson District Sales Manager

Jessie Chan

Senior Sales Representative

Alma Santiago

Sales Representative

Renee Watson

Sales Representative

Jerry Washington Senior Sales Representative
George Clark Sales Representative
William Frederick Senior Sales Representative

4. Create groups and parent/child relationships.

The following table lists the parent/child relationships for the groups for the

organization.

Group

Parent of:

National Sales

Western Region, Eastern Region

Western Region

Eastern Region

Northeast District, Southeast District, New

Products

Northeast District

Southeast District

New Products

5. Assign resources to groups.

The following table lists the resources assigned to each group.
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Scenario 1 — Organization Split Into Regions and Districts

Resource Role Group

Ruth Stamos National Sales Manager National Sales
Audrey Clark Regional Sales Manager Western Region
Richard Lee Regional Sales Manager Eastern Region
Ken Levy District Sales Manager Northeast District
Allison Hashimoto District Sales Manager Southeast District
Karen Gibson District Sales Manager New Products
Jessie Chan Senior Sales Representative ~ Northeast District
Alma Santiago Sales Representative Northeast District
Renee Watson Sales Representative Southeast District
Jerry Washington Senior Sales Representative  Southeast District
George Clark Sales Representative New Products
William Frederick Senior Sales Representative =~ New Products

6. Check hierarchy.

Refer to the Oracle CRM Application Foundation Concepts and Procedures for
information on accessing Resource Manager and group hierarchies.

a. Select Ruth Stamos from the Name LOV.
b. Select A1l from the View By LOV.
The Members section should show all resources in the organization.
c. Select Direct Reports from the View By LOV.
The Members section should only show Richard Lee and Audrey Clark.

Repeat this procedure for all resources.
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Scenario 2 - Security Based on Profile Options

C.2 Scenario 2 - Security Based on Profile Options

Senior Sales Representatives determine who works on each sale and can also
change price lists and discounts. Managers can edit their subordinates” quotes.

Setup of this scenario requires the following steps:

1. Set profile options for users.

The following table lists the profile option settings for each resource.

Resource Role Profile Option

Ruth Stamos National Sales Manager Set ASO: Manager Role
Access to Update

Audrey Clark Regional Sales Manager Set ASO: Manager Role
Access to Update.

Richard Lee Regional Sales Manager Set ASO: Manager Role
Access to Update.

Ken Levy District Sales Manager Set ASO: Manager Role
Access to Update.

Allison Hashimoto District Sales Manager Set ASO: Manager Role
Access to Update.

Karen Gibson

District Sales Manager

Set ASO: Manager Role
Access to Update.

Jessie Chan

Senior Sales Representative

Set ASO: Price List Override
to Yes.

Set ASO: Discounting
Privilege to Full.

Alma Santiago

Sales Representative

Set ASO: Price List Override
to No.

Set ASO: Discounting
Privilege to None.

Renee Watson

Sales Representative

Set ASO: Price List Override
to No.

Set ASO: Discounting
Privilege to None.

Jerry Washington

Senior Sales Representative

Set ASO: Price List Override
to Yes.

Set ASO: Discounting
Privilege to Full.
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Scenario 2 - Security Based on Profile Options

Resource Role Profile Option
George Clark Sales Representative Set ASO: Price List Override
to No.

Set ASO: Discounting
Privilege to None.

William Frederick Senior Sales Representative ~ Set ASO: Price List Override
to Yes.

Set ASO: Discounting
Privilege to Full.

C.2.1 Scenario 2 — New Quote Security

The East Region of the national sales organization has a group dedicated to working
across districts selling new products to existing customers. This group should have
the ability to create new quotes for all customers, whereas the Southeast and
Northeast district teams should only have access to quotes for which they are on the
sales team.

The profile option ASO: New Quote Security should be set at the user level.

Steps

1. For users on the Northeast and Southeast teams, set the profile to Sales Team.
2. For employees on the new product team, set the profile to Yes.

The following table lists the resources, their associated roles, and the profile
option settings.

Resource Role Profile Option

Jessie Chan Senior Sales Representative ~ Set ASO: New Quote
Security to Sales Team.

Alma Santiago Sales Representative Set ASO: New Quote
Security to Sales Team.

Renee Watson Sales Representative Set ASO: New Quote
Security to Sales Team.

Jerry Washington Senior Sales Representative ~ Set ASO: New Quote
Security to Sales Team.

George Clark Sales Representative Set ASO: New Quote
Security to None.
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Scenario 3 — Call Center Environment

Resource Role Profile Option

William Frederick Senior Sales Representative ~ Set ASO: New Quote
Security to None.

C.3 Scenario 3 — Call Center Environment

The organization has a call center that handles new and existing quotes. Sales
representatives are not dedicated to particular customers or quotes.

The profile ASO: Security Enable from API should be set to No. Therefore, no
security check is performed. This speeds up performance.
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D

Seeded Attributes in Oracle Approvals

Management (OAM)

D.1 Commonly Used OAM Seeded Attributes

Table D-1, "OAM Seeded Attributes for Oracle Quoting" displays seeded,
commonly used attributes, display level (header or line), attribute description, and

attribute type.

Table D-1 OAM Seeded Attributes for Oracle Quoting

Attribute Level Description Attribute Type
Quote Total Header Total quote amount.  Currency
Includes shipping
and freight charges
and taxes.
Quote Line Total Line Total quote line Currency
amount prior to
shipping and freight
charges and taxes.
Unit List Price Line Unit list price. Currency
Unit Net Price Line Unit net price. Currency
Manual Adjustment  Line Sum of the header Currency
Amount and line manual
adjustment/amounts
Manual Adjustment  Line Sum of the header Number

Percent

and line manual
adjustment
percentages.
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Mandatory Seeded OAM Attributes

Table D-1 OAM Seeded Attributes for Oracle Quoting

Attribute Level Description Attribute Type

Quantity Line Quantity Number

Unit of Measure Line Unit of measure String (List of Values,
when available)

Pricing Agreement Header Pricing agreement String (List of Values,
when available)

Price List Line Price list String (List of Values,
when available)

Item Category Line Item category String (List of Values,

(Defined in Inventory when available)

for the functional

area "Order Entry")

Item Number Line Item number String (List of Values,
when available)

Customer Name Header Name of the sold-to  String (List of Values,

customer when available)
Account Number Header Account number of  String (List of Values,

the sold-to customer

when available)

D.2 Mandatory Seeded OAM Attributes

OAM requires calling applications to populate specific mandatory attributes. All of
these attributes are at the header level. Table D-2, "OAM Mandatory Seeded
Attributes" lists seeded values and attribute types for these mandatory attributes.

Table D-2 OAM Mandatory Seeded Attributes

Attribute Attribute Type Value

ALLOW_DELETING_RULE_ Boolean False

GENERATED_APPROVERS

ALLOW_REQUESTOR_APPROVAL Boolean True

AT_LEAST_ONE_RULE_MUST _ Boolean False

APPLY

EFFECTIVE_RULE_DATE Date The date the quote is submitted
for approval.

TRANSACTION_DATE Date The date the quote is submitted

for approval.
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Non-Mandatory Seeded OAM Attributes

Table D-2 OAM Mandatory Seeded Attributes

Attribute Attribute Type Value
TRANSACTION_GROUP_ID Number Null
TRANSACTION_ORG_ID Number Org id of the quote
TRANSACTION_SET_OF_BOOKS_ID Number Null

TRANSACTION_ID Number Quote header id
TRANSACTION_REQUESTOR _ Number Person_id/fnd_user id of the
PERSON_ID requestor

D.3 Non-Mandatory Seeded OAM Attributes

The following seeded OAM attributes are not mandatory, but may be required
under certain circumstances. Table D-3, "Non-mandatory Seeded OAM Attributes"
displays the seeded values for Oracle Quoting.

Table D-3 Non-mandatory Seeded OAM Attributes

Attribute Attribute Type Value
INCLUDE_ALL_JOB_LEVEL_ Boolean False
APPROVERS

JOB_LEVEL_NON_DEFAULT_ Number Null

STARTING_POINT_PERSON_ID
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E

Oracle Quoting Seeded Caches

E.1 Oracle Quoting Seeded Caches

The following table displays Oracle Quoting’s seeded caches.

Table E-1 Seeded Caches for Oracle Quoting

Cache

Description

QOT_ATP_STATUS_CACHE

Stores information about ATP statuses, including
status code and meaning.

QOT_BOM_ITEM_TYPE_CACHE

Stores information about BOM item types,
including BOM item type code and meaning.

QOT_CREDIT_CARD_TYPE_CACHE

Stores information about credit card types,
including credit card type and name.

QOT_CURRENCY_CACHE

Stores information about currencies, including
currency code, meaning, symbol, and price list IDs.

QOT_IB_REL_TYPE_CACHE

Stores information about Install Base relationship
types, including relationship type code and
meaning.

QOT_ITEM_CTG_LIST_CACHE

Stores information about the list of item categories
available for a particular category set.

QOT_ITEM_TYPE_CACHE

Stores information about item types, including
item type code and meaning,.

QOT_LINE_TYPE_LIST_CACHE

Stores information regarding the list of lines types
available, based on operating unit, order type, and
line category.

QOT_LOOKUP_VALUES_CACHE

Stores information about lookup types and the
corresponding lookup values.
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Oracle Quoting Seeded Caches

Table E-1 Seeded Caches for Oracle Quoting

Cache

Description

QOT_MKTG_SRC_TYPE_CACHE

Stores information about marketing source types,
including source type code and name.,

QOT_MODIFIER_LEVEL_CACHE

Stores information about price modifier levels,
including code and name.

QOT_MODIFIER_LINE_TYPE_
CACHE

Store information about price modifier line types,
including code and name,

QOT_OU_CACHE

Stores information about operating units,
including operating unit ID and default territory
code.

QOT_PAYMENT_METHOD_CACHE

Stores information about payment methods,
including payment method code and meaning.

OOT_PAYMENT_TERM_CACHE

Stores information about payment terms, including
payment term ID and name.

QOT_PQUOTE_OUTPUT_FMT_
CACHE

Stores information about print quote formats,
including code and name.

QOT_PQUOTE_TEMPLATE_CACHE

Stores information about print quote templates,
including code and name.

QOT_PRICE_LIST_CACHE

Stores information about price lists, including price
list ID, name, and currency code.

QOT_QUOTE_STATUS_CACHE

Stores information about quote statuses.

QOT_RELATIONSHIP_TYPE_CACHE

Stores information about relationship types,
including relationship type code and meaning.

QOT_RESOURCE_CTG_CACHE

Stores information about resource categories,
including resource category code and meaning,.

QOT_RESOURCE_GROUP_CACHE

Stores information about resource groups,
including resource group ID and name.

OQT_SALESUPP_COMP_CACHE

Stores information about sales supplement
components, including component ID, name,
instruction, description, component type, response
type, and mandatory flag.

QOT_SALESUPP_RESP_CACHE

Stores information about sales supplement
responses, including response ID and name.

QOT_SALESUPP_SECT_CACHE

Stores information about sales supplement
sections, including section ID and name.
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Oracle Quoting Seeded Caches

Table E-1 Seeded Caches for Oracle Quoting

Cache Description

QOT_SALESUPP_TEMPL_CACHE Stores information about sales supplement
templates, including template ID and name.

QOT_SALES_CHANNEL_CACHE Stores information about sales channels, including
sales channel code and meaning.

QOT_SALES_CREDIT_TYPE_CACHE Stores information about sales credit types,
including sales credit type ID, name, and quota
flag.

QOT_SHIPPING_METHOD_CACHE Stores information about shipping methods,
including shipping method code and name.

QOT_TAX_CACHE Stores tax information, including tax code and
printed tax meaning.
QOT_TAX_EXEMPT_REASON_ Stores information about tax exempt reasons,
CACHE including tax exempt reason code and meaning.
QOT_TAX_EXEMPT_STATUS_ Stores information about tax exempt statuses,
CACHE including tax exempt status code and meaning.
QOT_TERRITORY_CACHE Stores information about territories, including

territory code and name.

QOT_TRANSACTION_TYPE_CACHE Stores information about transaction types,
including transaction type ID, name, code, and

price list ID.
QOT_TRXN_LINE_CTG_CODE Stores information about transaction line
categories, including line category code and
meaning.
QOT_UOM_CACHE Stores information about units of measure,

including UOM code and name.

QOT_YES_NO_CACHE Stores information about yes/no lookups,
including code and meaning.

Oracle Quoting Seeded Caches E-3



Oracle Quoting Seeded Caches

E-4 Oracle Quoting Implementation Guide



Glossary

API

An application programming interface (API) is a published interface comprising a
set of tools, routines, and protocols for building software applications.
Application tier

One of the three tiers in the Oracle Internet Computing Architecture model. The
application tier manages Oracle Applications and other tools. Also known as the
middle tier. See Internet Computing Architecture.

Attributes

Attributes are used to create criteria for the Pricing Qualifiers set up in Oracle
Pricing.

ATP (Availability to Promise)

The quantity of current on-hand, uncommitted stock, outstanding receipts and
planned production. In Oracle Inventory, you define the types of supply and
demand that should be included in your ATP calculation.

Bill-to customer

The name and financial account of the customer who will be invoiced for the goods
or services ordered.

Configurable item

The base model item to which a user may add components.
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Glossary-2

Database tier

One of the three tiers that make up Internet Computing Architecture. The database
tier manages the Oracle8i database. See Internet Computing Architecture.

Debugger

Debug messages notify the user every time a trigger starts to fire, and Debug Mode
allows you to dynamically view the execution of your triggers and variables.

Descriptive flexfield

A customizable field used to capture additional information not otherwise tracked
by Oracle applications. A descriptive flexfield appears in your window as a single-
character, unnamed field.

Desktop tier

One of the three tiers that make up Internet Computing Architecture. The desktop
tier provides the user interface display. See Internet Computing Architecture.

GSA (General Services Administration)

A customer classification indicating that the customer is associated with the U.S.
government. For products on the GSA price list, a fixed price must be used, defined
on the GSA contract. The GSA price is the lowest price offered. The items contained
on the GSA price list cannot be sold to non-GSA customers at or below the
government price.

Internet Computing Architecture

A framework for three tiered, distributed computing that supports Oracle
Applications products. The three tiers are the desktop tier, application tier or middle
tier, and database tier.

Lookup types

A predefined list of values. Each value in a lookup type has an internal and a
display name.

LOV (List of Values)

A list of valid values in a text field, from which the user must choose.

Manual discounts

The ability to manually override the list price of an item.



Middle tier
See Application tier.

Modifier

Modifiers define how Oracle Pricing makes adjustments, including discounts or
surcharges. In Oracle Pricing, when you set up modifiers, you define the
adjustments your customers may receive. You control the application of modifiers
by the pricing engine through rules that specify qualifiers, and through attributes
governing their use.

Qualifier

Qualifiers, which are defined in Pricing, control who receives price adjustments.

QuickCodes
See Lookup types.

Quote status

The quote status indicates the current stage of preparation for a specific quote. See
Section 4.1, "Setting Up Quote Status and Quote Status Transitions" for a complete
list of quote statuses.

Quote versioning

The quote version, which is part of the quote number, indicates the latest version of
the quote. If you set up quote versioning for quote statuses, the version increments
each time you change the status and save the quote.

Role

One or more users grouped by a common responsibility or position.

Role types

A collection of roles associated with a particular CRM module.

Sourcing rule

Sourcing rules are used by Oracle Pricing for binding attribute values for attributes
defined in a qualifier or pricing context.

Trade-in

A trade-in is performed when a customer wants to return an item for credit against
an order.
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Wildcard

A special character included in a search parameter that tells the application to
search for all records similar to the search parameter. In Oracle Quoting, the percent
sign, %, is the wildcard character. For example, when you enter "order%" as a quote
name search parameter, the application returns all quotes with names that begin
with "order."
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A

account creation requirements

profile options, 4-32

setting up, 4-32
adding quote statuses, 4-3
approvals

attributes, D-1

integration, 7-1

setting up, 7-2
assigning seeded responsibility, 4-9
attachments

adding document categories, 4-45
attributes

pricing, C-1

qualifier, C-1

Cc

cache

enabling, 4-9

modifying cache policy, 4-9
contracts

integration, 8-1,8-2

run background processes, 8-4

setting up, 4-35, 8-2

setting up independent conditions,
credit check

defining credit check rules, 4-37

external, 4-38

implementing user hooks, 4-39
internal, 4-36
setting up, 4-35

CRM Foundation profile options, A-31

Index

customizing

Lines page (HTML), 4-13
Details columns, 4-17
disable line actions, 4-17
disable table buttons, 4-17
display columns, 4-14
edit column labels, 4-15
edit column sequence, 4-16
enable line actions, 4-17
enable table buttons, 4-17
hide columns, 4-14

Overview page (HTML), 4-19

print quote report, 4-25

D

debugging
logging an iTar, 6-9
setting up, 6-9
default expiration date
based on calendar period, 4-10
based on fixed number of days, 4-11
setting up, 4-10
defining credit check rules, 4-37
dependencies
conditional, 2-10
mandatory, 2-2
descriptive flexfields, 4-45
defining, 4-45
disabling Action menus and buttons (HTML), 4-18
document categories, 4-45
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E

external credit check, 4-38
F

FAQs, 6-2

Order Feedback Queue, 6-2
flexfields
descriptive, 4-45

implementation

task sequence, 3-2

verifying, 5-1
interMedia search

enabling, 4-30

iStore Search Insert, 4-31

refreshing the index, 4-32
internal credit check, 4-36
iTar, 6-9

L

lookup types, 4-44
setting up, 4-44

manager roles, 4-21
mandatory dependencies, 2-2
manual pricing and tax calculation
enabling, 4-30
setting up, 4-29

N

notes from opportunities, 4-45

(o)

OAM attributes
seeded, D-1

Oracle Advanced Pricing
setting up, 2-4
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Oracle General Ledger
setting up, 2-9
Oracle Inventory
setting up, 2-9
Oracle Order Management
setting up, 2-9
Oracle Receivables
address formats, 2-3
setting up, 2-3
Order Feedback Queue
FAQs, 6-2
Order Management
profile options, A-34
overrideable modifiers
setting up, 4-11

P

pricing
attributes, C-1

print quote
adding new templates, 4-27
adding report template, 4-26
customizing disclaimer, 4-26
customizing report, 4-25

customizing the report title, 4-26
disabling report templates, 4-26

finding document ID, 4-26
product categories, 4-28
setting up, 4-24
print quote templates
adding new, 4-27
profile options, 4-8
CRM Foundation, A-31
Order Management, A-34
Quoting, A-2
Self Service Web Applications,
setting, 4-8
setting up security, 4-21
proposals
setting up, 4-34

Q

quote status



rules for changes, 4-5
Quote Status Setup window,
quote statuses

disabling, 4-3

enabling, 4-3

setting up, 4-3
quote versioning, 4-3
Quoting

conditional dependencies,

dependencies, 2-2

features, 1-2

new features, 1-3

overview, 1-2

profile options, A-2
Quoting profile options, A-2

approvals, A-2

ATP, A-3

Configurator, A-5

Contracts Integration, A-6

Credit Checks, A-6

Debugging, A-7

Expiration Date, A-8

Inventory, A-9

Manual Discounts, A-9

Orders, A-10

OSO Integration, A-14

Payments, A-14

Pricing and Tax, A-15

Print Quote, A-16

Quote Templates, A-17

Quotes, A-18

Sales Supplement, A-22

Searching, A-23

Security, A-23

Trade ins, A-30

Web Publishing, A-31

R

4-7

2-10

report templates

adding or disabling, 4-26
resources

creating, 4-21
responsibility

seeded, 4-9

rul

S

es for quote status changes, 4-5

sales supplement

setting up templates, 4-40

security

creating resources, 4-21
scenarios, C-1

setting up, 4-20

setting up groups, 4-22

setting up manager roles, 4-21
setting up security profile options,

setting up

sid

T

debugging, 6-9

lookup types, 4-44

print quote, 4-24

profile options, 4-8

quote status, 4-3

quote status transitions, 4-3
ebar menu

4-21

removing links to unused functionality,
specialty stores, 4-35

4-11

tasks from opportunities, 4-46
Trade, A-30

tro

w

ubleshooting
common errors, 6-5
FAQs, 6-2

web publishing

enabling, 4-34
setting up, 4-34
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